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1 Introduction

1.1 About this manual
This manual provides information on how to set and configure the device
parameters of a netX based PROFINET IO-Controller using the PROFINET
IO-Controller DTM, and what can be read from the diagnosis panes.

The configuration of the Sync domain settings for RT or IRT-capable
PROFINET IO-Devices is enclosed.

Refer to the operating instruction manual “netDevice and
netProject” how to create a network configuration, or to the
operating instruction manual for the generic DTM, for PROFINET
IO-Devices, how to configure the PROFINET IO-Device.
For information concerning the configuration of the topology of
devices in domains for isochronous real-time communication (IRT),
refer to the operating instruction manual Topology Editor.

Error codes

All status and error codes you find in the API manual "Hilscher
status and error codes".

1.1.1 Online help
The PROFINET IO-Controller DTM contains an integrated online help.
Ø To open the online help, click on Help or press F1.

1.1.2 List of revisions
Index Date Version Component Changes
6 2022-04-25 1.200 (and

1.0200)
PNIOController.dll,
PNIOControllerGUI.ocx

Document revised.
Chapter Error codes removed. See API Manual
"Hilscher status and error codes" instead.

7 2022-06-13 1.200 (and
1.0200)

PNIOController.dll,
PNIOControllerGUI.ocx

Corrections.

8 2023-07-20 1.200 (and
1.0200)

PNIOController.dll,
PNIOControllerGUI.ocx

Sections Controller network settings [} page 71]
and Address table [} page 82] updated.
Section Access to online functions [} page 20]
added.

Table 1: List of revisions
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1.2 Overview use cases
In the table below you find an overview of the applicable use cases.

Use case Description Chapter, section
Device start up · Creating project configuration

· Start/stop communication

Device start up [} page 15]
Create project configuration [} page 19]
Start/stop communication [} page 21]

Driver and device
assignment settings

· Verifying or adapting driver settings
· Configuring drivers
· Assigning device (with or without

firmware)
· Selecting and downloading firmware

Verifying or adapting driver settings [} page 23]
Configuring drivers [} page 25]
Assigning device (with or without
firmware) [} page 32]
Selecting and downloading firmware [} page 37]

Configuring Ethernet
devices

(device name and IP address) Ethernet devices [} page 44]

Licensing (licenses for master protocols) Licensing [} page 57]
Configuring device
parameters

· Configuring IRT communication
· Controller network settings
· Device table
· IP address table
· Set process data
· Isochronous modules
· Set device address
· FSU/Port settings
· Station timing
· Controller settings

Configuring IRT communication [} page 70]
Controller network settings [} page 71]
Device table [} page 74]
IP address table [} page 76]
Process data [} page 78]
Isochronous modules [} page 79]
Address table [} page 82]
FSU/port settings [} page 85]
Stations timing [} page 87]
Controller settings [} page 104]

Connecting/disconnecting
device

Establishing online connection Connecting/disconnecting device [} page 107]

Downloading configuration Download to the device Download configuration [} page 109]
Importing network structure
and upload

Identifying network configuration
automatically.

Network scan and upload [} page 111]

Diagnosis · General diagnosis
· Master diagnosis
· Station diagnosis
· Firmware diagnosis

Overview diagnosis [} page 125]
General diagnosis [} page 126]
Master diagnosis [} page 128]
Station diagnosis [} page 129]
Firmware diagnosis [} page 130]

Extended diagnosis Finding communication/configuration
errors.

Overview extended diagnosis [} page 131]

Packet Monitor Test of send and receive data. Packet monitor [} page 141]
IO Monitor Test of communication. I/O monitor [} page 144]
Process Image Monitor Display fieldbus structure and data

structure of the input and output data of
the devices transmitted on the bus.

Process image monitor [} page 145]

User rights Definition of access rights User rights [} page 148]
Table 2: Overview use cases
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1.3 System requirements
· PC with 1 GHz processor or higher
· Windows® XP SP3,

Windows® Vista (32-bit) SP2,
Windows® 7 (32-bit and 64-bit) SP1,
Windows® 8 (32-bit and 64-bit),
Windows® 8.1 (32-bit and 64-bit),
Windows® 10 (32-bit and 64-bit), 
Windows® 11 (32-Bit and 64-Bit)

· Administrator privilege required for installation
· Internet Explorer 5.5 or higher
· RAM: min. 512 Mbyte, recommended 1024 Mbyte
· Graphic resolution: min. 1024 x 768 pixels
· Keyboard and mouse
· Restriction: Touch screen is not supported.

Note:
If the project file is used on a further PC,
- this PC must also comply with the above system requirements,
- the device description files of the devices used in the project must
be imported into the configuration software SYCON.net on the new
PC,
- and the DTMs of the devices used in the project must also be
installed on that further PC.
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1.4 About the PROFINET IO-Controller DTM
The PROFINET IO-Controller DTM is used to configure a PROFINET IO-
Controller device. The configuration is done using the FDT frame
application SYCON.net, which serves as configuration software.

1.5 Requirements PROFINET IO-Controller DTM
To configure the a PROFINET IO-Controller device with the PROFINET IO-
Controller DTM the following requirements have to be accomplished:
· Completed hardware installation of a netX based DTM-compatible

PROFINET IO-Controller device, including loaded firmware, license and
loaded configuration file

· Installed FDT/DTM frame application (V1.2 compliant)
· Loaded DTM in the device catalog of the FDT framework
· Additional requirements for the topology editor: 

Microsoft .NET Framework 4.0

Note:
If the PROFINET IO-Controller DTM and the PROFINET IO-
Controller device are installed on the same PC, the cifX device
driver must be installed on that PC, as you can connect the DTM to
the device.

For more information to the hardware installation, please refer to the
corresponding User Manual of your device. Information on how to
order and to download the license to the device, you will find in this
manual in the sections about the use case "Licensing".
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1.6 DTM dialog structure
The graphical user interface of the DTM is divided into different areas and
elements:
1. The header area with the General device information,
2. the Navigation area (on the left side),
3. the Dialog pane (on the right side),
4. OK, Cancel, Apply, Help,
5. the Status bar with DTM state information.

Figure 1: Dialog structure of the Device Type Manager

1.6.1 General device information
Parameter Description
IO device Device name
Vendor Vendor name of he device
Device ID Identification number of the device
Vendor ID Identification number of the vendor

Table 3: General device information
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1.6.2 Navigation area
In the navigation area, you can select the individual dialog panes via the
folder structure of the DTM.

Figure 2: Navigation area

Ø Select the required folder and subfolder.
ð The corresponding dialog pane appears.
Ø Click , to hide or to open the navigation area.

1.6.3 Dialog pane
In the dialog pane area, the different windows of the DTM appear only with
displayed information or for required setting steps. You call up the
respective windows via the associated folder in the navigation area.

1.6.4 OK, Cancel, Apply, Help,
In the configuration software the following is valid:

Description
OK To confirm your latest settings, click OK.

All changed values will be applied on the frame application database. The dialog then closes.
Cancel To cancel your latest changes, click Cancel.

Answer to the safety query "Configuration data has been changed. Do you want to save the data?" by
Yes, No or Cancel.
· Yes: The changes are saved or the changed values are applied on the frame application database.

The dialog then closes.
· No: The changes are not saved or the changed values are not applied on the frame application

database. The dialog then closes.

· Cancel: Back to the DTM.
Apply To confirm your latest settings, click Apply.

All changed values will be applied on the frame application database. The dialog remains opened.
Help To open the DTM online help, click Help.

Table 4: OK, Cancel, Apply, Help
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1.6.5 Status bar
In the status bar, graphical icons display the current DTM state (e. g.,
connection or download status, or other activities).

Figure 3: Status bar – status fields 1 to 6

Status 
field

Icon / description

1 DTM connection states
Connected: Icon closed = Device is online

Disconnected: Icon opened = Device is offline

2 Data source states
Data set: The displayed data is read out from the instance data set
(database).

Device: The displayed data is read out from the device.

3 States of the instance date set
Valid Modified: Parameter is changed (not equal to data source).

4 Changes directly made on the Device
Load/configure diagnosis parameters: Diagnosis is activated.

6 Device diagnosis status
Save operation succeeded: The save operation has been successful.
Further messages due to successful handling of device data.
Firmware Download: Firmware download is running

Save operation failed: The save operation has failed.
Further fail operation messages due to incorrect communication due to
malfunction in the field device or its peripherals.

Table 5: Status bar icons [1]

Offline state

Save operation
succeeded
Firmware download

Firmware download
successful
Online state and
diagnosis

Table 6: Status bar, display examples
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2 Safety

2.1 General note
The documentation in the form of a user manual, an operating instruction
manual or other manual types, as well as the accompanying texts, have
been created for the use of the products by qualified personnel. When
using the products, all Safety Messages, Integrated Safety Messages,
Property Damage Messages and all valid legal regulations must be obeyed.
Technical knowledge is presumed. The user has to assure that all legal
regulations are obeyed.

2.2 Intended use
The PROFINET IO-Controller DTM serves for configuration and diagnosis
of PROFINET IO-Controller devices.

2.3 Personnel qualification
Personnel responsible for the application of the network system shall be
aware of the system behavior and shall be trained in using the system.
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2.4 Safety messages

2.4.1 Communication stop caused by firmware or configuration download
If you want to perform either a firmware update (as a download) or a
configuration download, both via the PROFINET IO-Controller DTM, please
be aware of the following:
· Together with the firmware download, an automated reset to the device

is performed that will interrupt all network communication and all
established connections will drop.

· If you download the firmware or the configuration during bus operation,
the communication between master and slaves stops and a plant stop
may occur.

Possible faulty system operation
· Unpredictable and unexpected behavior of machines and plant

components due to a plant stop may result in personal injury and
damage to your equipment.

Ø Stop the application program, before starting the firmware update or
before downloading the configuration.

Ø Make sure that your equipment operates under conditions that prevent
personal injury or property damage. All network devices should be
placed in a fail-safe mode, before starting the firmware update or before
downloading a configuration.

Loss of device parameters, overwriting of firmware
· A communication stop can cause device parameters to be lost and

damage to the device.
· Both the firmware download and the configuration download erase the

configuration database. The firmware download overwrites the existing
firmware in the network device.

Ø To complete the firmware update and to make the device operable
again, re-load the configuration after the firmware update has been
finished.

Device parameters that have been saved volatile, e. g. as the temporarily
set IP address parameters, are getting lost during the reset.
· In order to prevent loss of configuration data, make sure that your

project configuration data are saved non-volatile, before you initiate a
firmware update or download the configuration.

Ø In order to prevent loss of configuration data, before you initiate a
firmware update or download the configuration, make sure that your
project configuration data are saved non-volatile.

2.4.2 Mismatching system configuration
Mismatching system configuration loaded into the device may result in
faulty data mapping in the application program. Thus, unexpected
equipment operation may cause personal injury or damage to equipment.
Ø In the device, use only a configuration suitable for the system.
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2.5 Property damage

2.5.1 Power disconnect during firmware or configuration download
If during the process of downloading a firmware or configuration,
· the power supply to a PC with the software application is interrupted,
· or the power supply to the PROFINET IO-Controller device is

interrupted,
· or a reset to the device is done.

This may lead to the following consequences:

Loss of device parameters, firmware corruption
· The firmware download or the configuration download is interrupted and

remains incomplete.
· The firmware or the configuration database will be corrupted and device

parameters will be lost.
· Damage to the device may occur, as the device cannot be rebooted.

Whether these consequences occur depends on when the power
disconnect occurs during the download.
Ø During firmware or configuration download process, do not interrupt the

power supply to the PC or to the device, and do not perform a reset!

Otherwise, you might be forced to send in your device for repair.

Power drop during write and delete accesses in the file system

The FAT file system in the netX firmware is subject to certain limitations in
its operation. Write and delete accesses in the file system (firmware
update, configuration download etc.) can destroy the FAT (File Allocation
Table) if the accesses cannot be completed if the power drops. Without a
proper FAT, a firmware may not be found and cannot be started.

Make sure that the power supply to the device is not interrupted during
write and delete accesses in the file system (firmware update, configuration
download, etc.).

2.5.2 Invalid firmware
Loading invalid firmware files could render your module unusable.
Ø Only load firmware files to the device that are valid for this device.

Otherwise, you might be forced to send in your device for repair.
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3 Device start up

3.1 Configuration steps
The following overview provides to you the step sequence on how to
configure a netX based PROFINET IO-Controller device with PROFINET
IO-Controller DTM as it is typical for many cases. It is assumed at this point
that the hardware installation has been completed.

Step Brief description Further information
Add PROFINET IO-Device
in the device catalog

Open configuration software SYCON.net.
Add device by importing the device description file to the
Device Catalog.
- Network > Import device descriptions.

Section Create project
configuration [} page 19], or
Operating instruction manual
“SYCON.net” and Operating
instruction manual “netDevice
and netProject”

Load device catalog - Select Network > Device catalog,
- Reload catalog.

Create / open project - Select File > New or File > Open.
Insert the controller device
and the Device into
configuration

- In the Device catalog, select the controller device and
insert the device via drag & drop to the line in the
network view.
- In the Device catalog, select the Device and insert the
device via drag and drop to the master bus line in the
network view.*
*This step will not be necessary if the network structure
is scanned automatically.

Open controller DTM
configuration dialog

- Double click to the device icon of the controller.
- The DTM configuration dialog is displayed.

-

Verify or adapt driver
settings

- Select Settings > Driver.
Note! For PC cards cifX the cifX device driver is preset
as a default driver. For all the other Hilscher devices, the
netX driver is preset as a default driver.
· Use the cifX device driver if the PROFINET IO-

Controller DTM is installed on the same PC as the
PROFINET IO-Controller device.

· Use the netX driver to establish a USB, Serial
(RS232) or TCP/IP connection from the PROFINET
IO-Controller DTM to the PROFINET IO-Controller
device.

· The 3Sgateway driver for netX (V3.x) is used only in
relationship with CODESYS.

To search for devices you can check one or multiple
drivers simultaneously.
- Verify that the default driver is checked.
- If necessary, check another driver or multiple drivers.

Section Verifying or adapting
driver settings [} page 23]
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Step Brief description Further information
Configure driver If you use the netX driver, you respectively must

configure it.
For netX Driver and communication via TCP/IP set
the IP adress of the device.
- Select Settings > Driver > netX driver > TCP
connection.

- Via  add an IP range.
- Under IP address enter the IP Address of the device
or an IP range.
- Click Save.
Adjust the driver parameters netX driver USB/RS232
only if they differ from the default settings.
Note!
· The cifX device driver requires no configuration.
· The configuration of the 3Sgateway driver for netX

(V3.x) is carried out via the CODESYS user interface.

Configuring netX
driver [} page 26]

Assign controller device to
the driver (with or without
firmware)

- Select Settings > Device assignment.
- Under Device selection, select suitable only or all and
click Scan.
- In the table, check the required devices.
- Click Apply.

Assigning device (with or without
firmware) [} page 32]

Select and download
firmware

If not yet a firmware was loaded to the device:
- Adhere to the necessary safety precautions to prevent
personnel injury and property damage.
- Select Settings > Firmware download,
- clock Browse..,
- select a firmware file,
- click Open.
- Click Download and Yes.

For further details, please refer
to the Safety chapter.

Selecting and downloading
firmware [} page 37]

Assign controller device
once more (with firmware
and system channel)
For repeated download this
step is omitted.

- Select Settings > Device assignment,
- click Scan,
- In the table, check the required device.
- Click Apply.

Selecting the device once more
(with firmware) [} page 35]

Configuring Ethernet
devices

In the controller DTM configuration dialog:
- Select Settings > Ethernet devices,
- click Devices online > Search devices,
- under Devices online click the line for the device to be
configured.
- Respectively check Use configuration of and select a
device, the configuration of which shall be used. 
- Set the device name (=Name of Station) newly or
overtake it, 
- click Set name,
- set the IP address, subnet mask and gateway address
newly or overtake them,
- click Set address,
- click Search devices once more to display the newly
adjusted current values.
- Close the controller DTM configuration dialog via OK.

Section Ethernet
devices [} page 44]

Configure Device*
(*This step will not be
necessary if the network
structure is scanned
automatically.)

- In the slave DTM dialog select Configuration >
Modules.
- Configure the modules of the Device.
- Select Device settings.
- Set the Device settings.
- Close the dialog via OK.

Operating instruction manual
“Generic DTM for PROFINET
IO-Devices”
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Step Brief description Further information
Configure controller device
(with IRT communication)
For Device:
Set Name of Station and 
IP settings.

- In the controller DTM configuration dialog, select
Configuration 
- Select Controller network settings.
- Set the name of station and the IP settings of the
controller, and possibly make further settings. 
- Select Device table.
- Configure the Devices for data exchange with the
controller and enter a name of station for each.
- Select IP address table.
- Enter the IP settings for the Devices.
- Select Process data.
- Assign symbolic names for the configured modules or
signals.
- Select Isochrone modules.
- Enable isochrone mode and set parameters.
- Select Address table. 
- Enable or disable auto addressing. 
- For manual addressing: Enter addresses. 
- Select FSU/port settings.
- Check FSU for the Devices that should establish a
connection via Fast-Start-up (FSU) for the cyclic data
exchange. 
- Set the MAU type of the Devices or ports.
- Select Stations timing.
- Select each device station connected to the controller
and make the station global and Sync domain settings.
- Select Controller settings.
- Check the parameters and adjust them if necessary,
e.g. start of the bus communication, watchdog-time of
the application monitoring, port settings.
- Close the dialog via OK.

Configuring IRT
communication [} page 70]
Controller network
settings [} page 71]
Device table [} page 74]
IP address table [} page 76]
Process data [} page 78]
Isochronous
modules [} page 79]
Address table [} page 82]
FSU/port settings [} page 85]
Stations timing [} page 87]
Controller settings [} page 104]

Configure topology Settings in the topology editor to make:
- Connect the devices.
- Configure the properties for devices and ports.

Operating instruction manual
“Toplogy Editor”

Save project - Select File > Save. Operating instruction manual
“SYCON.net”

Connect controller device - Right click to the device icon of the controller,
- Select Connect.

Section Connecting/
disconnecting
device [} page 107]

Download configuration - Adhere to the necessary safety precautions to prevent
personnel injury and property damage that may occur in
consequence of a communication stop or in
consequence of a mismatching system configuration.
- Right click to the device icon of the controller,
- Select Download.

Section Download
configuration [} page 109]

Network scan / upload Alternative to manual configuration of the Device, you
can scan the network structure (in the controller DTM)
and upload the Device configuration. Proceed as
follows:
1. Click Network scan.
2. Make the settings in the Scan response dialog.
3. Click Create devices.
4. Download the IP settings of the Device to the
controller device.
5. Click Upload (in the device DTM), and create the
Device module configuration.
6. Download the current Device configuration to the
controller device.

Section Network scan and
upload [} page 111]
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Step Brief description Further information
Diagnosis - Right click to the device icon of the master.

- Select Diagnosis.
- The diagnosis dialog appears.
(1.) Check whether the communication is OK:
Diagnosis > General diagnosis > Device status
“Communication” must be green!
(2.) “Communication” is green: Open the IO monitor
and test the input or output data. 
(3.) “Communication” is not green: Use diagnosis and
extended diagnosis for troubleshooting.
- Close the dialog via OK.

Section
Diagnosis [} page 125] 

Section 
Extended diagnosis [} page 131]

I/O monitor - Right click to the device icon of the master,
- select Diagnosis,
- select Tools > I/O monitor,
- check the input or output data.
- Close the dialog via OK.

Section I/O monitor [} page 144]

Disconnect - Right click to the device icon of the Master,
- select Disconnect.

Section Connecting/
disconnecting
device [} page 107]

Table 7: Getting started – Configuration steps
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3.2 Create project configuration
1. Complete the Device in the device catalog.

Ø Select Network > Import device descriptions.
Ø Import the device description file.

2. Load device catalog.
Ø Select Network > Device catalog.
Ø Select Reload catalog.

3. Create or open a project.
Ø Create new project / open existing project:
Ø Select File > New or File > Open.

4. Insert controller device or Device to the configuration.
Ø In the device catalog, click to the controller device, and insert it via drag

and drop to the line in the network view.
Ø In the device catalog, click to the Device.*
Ø Or, select the correct device instance for the Device.* For more

information, see operating instruction manual of the PROFINET IO-
Device DTM.

Ø Insert the Device via drag and drop to the master bus line in the
network view.*

*This step will not be necessary if the network structure is scanned
automatically.

Note:
In order to select the desired device in the device catalog, note the
details about the DTM and the device at the bottom of the device
catalog window. When sorting by fieldbus, several devices with the
same name from different vendors can be displayed.

For further information, see operating instruction manual
"SYCON.net" or "netDevice and netProject".
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3.3 Access to online functions

Getting access to “Network scan”

Note:
If under Configuration > Master settings > Start of bus
communication the setting Controlled by application was
selected, the master device is in ‘Offline’ state after ‘Power on
Reset’! In this state, you cannot use the SYCON.net online function
Network scan.
Ø To access this online function when the master device is

working together with an application program, the application
program must start the communication.

Ø Alternatively, you can start the communication manually from
the context menu of the master device via Start
communication.

3.4 Importing network structure and "upload"
As an alternative to manually configure the Device, you can automatically
scan the network structure by using the context menu Network scan. Then
you can create the module configuration of the Device by configuration
upload and download it to the controller device.

Take the following steps:
1. Start the Network scan (in the controller DTM).
2. Make the settings in the Scan response dialog.
3. Click Create devices.
4. Via Download, download the IP settings of the Device to the controller

device.
5. Via Upload (in the device DTM), upload the device configuration of

each Device to the controller DTM, and create the module configuration.
6. Via Download (in the controller DTM), download the current

configuration of the Devices to the controller device.

For more information, refer to the section Network scan and
upload [} page 111].
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3.5 Start/stop communication
You can manually start or stop the communication between a PROFINET
IO-Controller device and PROFINET IO-Devices.
· Start communication can be enabled if the communication was

stopped before or if the configuration requires this (controlled release of
communication).

· Stop communication can be enabled if the communication was
started.

To start or to stop the communication, proceed as follows:

Start communication
Ø Connecting device:

Note:
To manually start the communication of the device at the bus, an
online connection from the PROFINET IO-Controller DTM to the
PROFINET IO-Controller device is required. Further information can
be found in the section Connecting/disconnecting
device [} page 107].

Ø Select Additional functions > Service > Start communication from
the context menu (right mouse click).

ð The device communicates at the bus.

Stop communication

 Faulty system operation possible, overwriting of firmware
or loss of device parameters

Before stopping the communication:
Ø Stop the application program.
Ø Make sure that all network devices are in a fail-safe condition.

After carrying out the security measures:
Ø Select Additional functions > Service > Stop communication from

the context menu (right mouse click).
ð The communication of the device at the bus is stopped.

DTM for Hilscher PROFINET IO-Controller devices (RT/IRT) | Configuration of contoller devices
DOC150704OI08EN | Revision 8 | English | 2023-07 | Released | Public

© Hilscher 2015 – 2023



Settings 22/164

4 Settings

4.1 Overview settings for driver and device assignment
Under "Settings" you can make different basic settings for your device:
· To establish a connection from the PROFINET IO-Controller DTM to the

PROFINET IO-Controller device, check whether the default driver is
hooked up in the dialog pane Driver and if necessary, check another or
several drivers.

· In the Device assignment pane, select the device and assign it to the
driver.

· The dialog in the Firmware download pane is used to load a new
firmware into the device.

· The dialog in the Licensing or License pane allows you to order
licenses for master protocols and utilities and transfer them to your
device.

· In the Ethernet devices dialog, you can set the device name or IP
address for Ethernet-enabled devices.

Figure 4: Navigation area - Settings (example)

There may be more drivers.

Note:
To edit the dialog panes under Settings, you need the user rights
for "Maintenance".
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4.2 Verifying or adapting driver settings
The Driver dialog pane displays the drivers available to establish a
connection from the PROFINET IO-Controller DTM to the device.

Note:
A default driver is set in the configuration software.

Proceed as follows:
1. Select driver.

Ø Select Settings > Driver in the navigation area.
ð The Driver dialog pane is displayed. This shows the available drivers

and the pre-setting of the default driver.

Figure 5: Default driver ‚cifX Device Driver’ for PC cards cifX (example)

Figure 6: Default driver ‚netX Driver’ for Hilscher devices except for PC cards cifX (example)

Parameter Description
Driver Name of the driver. (For further details, see the descriptions of the action steps.)

Default driver (Pre-settings in the configuration software): For PC cards cifX the cifX device driver is
preset as a default driver. For all the other Hilscher devices the netX driver is preset as a default driver.
To search for devices you can check multiple drivers simultaneously.

Version ODMV3 version of the respective driver
ID ID of the driver (driver identification)

Table 8: Parameters of the driver selection list

2. Verify whether the default driver is checked.
Ø To establish a connection from the PROFINET IO-Controller DTM to the

PROFINET IO-Controller device, check whether the default driver is
hooked up in the dialog pane Driver and if necessary, check another or
several drivers.

3. Respectively check another driver or multiple drivers.
Ø Check the checkbox for the driver in the selection list.

Note:
The driver used for the connection from the PROFINET IO-
Controller DTM to the PROFINET IO-Controller device must be
supported by the device and must be available for the device.
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· Use the cifX device driver if the PROFINET IO-Controller DTM is
installed on the same PC as the PROFINET IO-Controller device.

· Use the netX driver to establish an USB, Serial (RS232) or TCP/IP
connection from the PROFINET IO-Controller DTM to the PROFINET
IO-Controller device.

· The 3Sgateway driver for netX (V3.x) is used only in relationship with
CODESYS. The version V3.x refers to the driver version defined by 3S-
Smart Software Solutions GmbH.

To search for devices on the network you can check multiple drivers
simultaneously.

Figure 7: Manual selection of multiple drivers (example)
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4.3 Configuring drivers

4.3.1 cifX device driver
In the PROFINET IO-Controller DTM for the cifX device driver no driver
dialog pane is available, since for the cifX device driver no driver settings
are required.

The cifX device driver will be used if the PROFINET IO-Controller DTM is
installed in the same PC as the PROFINET IO-Controller device.

Note:
To establish a connection from a DTM to a controller device via the
cifX device driver, the cifX device driver must be installed and the
driver must have access to the controller device.

4.3.2 netX driver
The netX driver is used to connect the DTM to the device via different
connection types. The DTM communicates with the device via an USB
connection, a serial (RS232) connection or a TCP/IP connection. The netX
Driver establishes
· via the USB interface of the device and the USB port of the PC an USB

connection to the device,
· via the RS232 interface of the device and the COM port of the PC a

serial connection (RS232) to the device,
· and, via Ethernet a TCP/IP connection to the device.

To connect the DTM to the physical layer of the device the netX driver
software works in combination with the software components:
· “USB/COM connector” for the USB connection and for the serial

connection (RS232) and,
· “TCP connector” for the Ethernet connection.

Descriptions of the netX Driver are available in the DTM user
interface as online help:
Ø Therefore, click Settings > Driver > netX driver and press the

F1 key.
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4.3.3 Configuring netX driver
The following steps are required to configure the netX driver:

USB/RS232 Connection

To set the driver parameters for an USB/RS232 connection note:

Note:
Adjust the driver parameters netX driver USB/RS232 only if they
differ from the default settings. After saving the changed driver
parameters, these parameters are used for the device assignment
when scanning devices.

For setting the driver parameters for an USB connection or a serial
connection:

1. Set the driver netX driver USB/RS232 parameters.
Ø Open the driver dialog via Settings > Driver > netX driver > USB/

RS232 connection.

TCP/IP connection

For setting the driver parameters for a TCP/IP connection:

2. Set IP address of the device.
Ø Select Settings > Driver > netX driver > TCP connection.

Ø Add an IP range via Select IP range .
Ø Under IP range configuration > IP address enter the IP address of the

device (Use IP range is unchecked).
3. Or set IP range:

Ø Check Use IP range.
Ø Under IP range configuration > IP address enter the start address

(left side) and the ending address of the IP scanning range (right side).
4. Save the IP address or the IP search range.

Ø Click on Save.
ð After saving the changed driver parameters, these parameters are used

for the device assignment when scanning devices.
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4.3.4 netX driver - USB/RS232 connection
The communication from the DTM to the device via an USB/RS232
connection is used when the DTM is installed on a PC and between the PC
and the device
· an USB connection,
· or a serial connection (RS232) exists.

The DTM accesses the device via the USB interface or via the RS232
interface. This requires either to connect an USB port of the PC to the USB
interface of the device using an USB cable or to connect a physical COM
port of the PC to the RS232 interface of the device via a serial cable.

The netX driver / USB/RS232 connection supports all physical and virtual
COM ports available on the PC.

Via the RS232 interface or USB interface, the device is configured or
diagnosis is performed.

4.3.4.1 Driver parameters for netX driver - USB/RS232 connection

The settings of the driver parameters for the USB/RS232 connection are
made via the netX driver / USB/RS232 connection configuration dialog.
Ø Open the USB/RS232 connection dialog via navigation area Settings

> Driver > netX driver.
Ê The USB/RS232 connection dialog is displayed:

Figure 8: cifX driver > USB/RS232 connection

DTM for Hilscher PROFINET IO-Controller devices (RT/IRT) | Configuration of contoller devices
DOC150704OI08EN | Revision 8 | English | 2023-07 | Released | Public

© Hilscher 2015 – 2023



Settings 28/164

Parameter Description Range of value /
value

Enable USB/RS232
connector (restart of
ODM required)

checked: The cifX driver can communicate via the USB/RS232 interface.
unchecked: The cifX driver cannot communicate via the USB/RS232
interface.
If the check mark for Enable USB/RS232 connector is set or removed,
then the ODM server must be restarted1, to make the new setting valid.
_______
1 Restart the ODM server via the ODMV3 tray application:

- In the foot line click on  using the right mouse key.
- In the context menu select Service > Start.

checked, 
unchecked; 
Default: 
unchecked

Select port Depending on the COM ports (interfaces) available on the PC, they will be
listed under Select port.

COM 1 to COM N

Port configuration
Disable port checked: No connection.

unchecked: The cifX driver tries to establish a connection using the
configured USB/RS232 interface.

checked, 
unchecked (Default)

Baud rate Transfer rate: Number of bits per second.
The device must support the baud rate.

9.6, 19.2, 38.4, 57.6
bzw. 115.2 [kBit/s];
Default (RS232):
115.2 [kBit/s]

Stop bits Number of stop bits sent after the transfer of the send data for
synchronization purposes to the receiver.

Stop-Bit: 1, 1.5, 2;
Default (RS232): 1

Send timeout Maximum time before the transfer of the transmission data is canceled,
when the send process fails, for example, because of the transfer buffer is
full.

100 … 60.000 [ms]; 
Default (RS232 and
USB): 1000 ms

Reset timeout Maximum time for a device reset, including the re-initialization of the
physical interface used for the communication.

100 … 60.000 [ms];
Default (RS232 und
USB): 5000 ms

Byte size Number of bits per byte by byte specification 7 Bit, 8 Bit; 
Default (RS232): 8
Bit

Parity In the error detection in data transmission using parity bits, "parity"
describes the number of bits occupied with 1 in the transmitted
information word.
No Parity: no parity bit
Odd Parity: The parity is "odd" if the number of bits occupied with 1 in the
transmitted information word will be odd.
Even parity: The parity is "even" if the number of bits occupied with 1 in
the transmitted information word will be even.
Mark Parity: if the parity bit is always 1, this will be named mark-parity
(the bit does not contain any information).
Space Parity: if the parity bit always 0, this will be named space-parity
(the bit represents an empty space).

No Parity, 
Odd Parity,
Even Parity,
Mark Parity,
Space Parity;
Default (RS232): 
No Parity

Keep alive timeout The "Keep Alive" mechanism is used to monitor whether the connection
to the device is active. connection errors are detected using a periodic
heartbeat mechanism. The heartbeat mechanism will be initiated after the
set time has elapsed if the communication has failed.

100 … 60.000 [ms];
Default (RS232 und
USB): 2000 ms

Restore Resets all settings in the configuration dialog to the default values.
Save Saving all settings made in the configuration dialog cifX driver > USB/

RS232 connection, i. e. only for the selected connection type.
Save all Saving all settings made in the configuration dialog cifX driver, i. e. for all

connection types.
Table 9: Parameters cifX driver > USB/RS232 connection
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4.3.5 netX driver - TCP/IP connection
The communication from the DTM to the device via a TCP/IP connection
is used in the following two typical applications:

Application 1: The device has its own Ethernet interface. The DTM is
installed on a PC and the TCP/IP connection is established from this PC to
the stand-alone device. The IP address of the device is used.

Application 2: The device is installed in a remote PC. The DTM is installed
on an additional PC and the TCP/IP connection is established from this PC
to the remote PC. The IP address of the remote PC is used. For the TCP/IP
connection is made, on the remote PC the cifX TCP/IP server must be
started. The cifX TCP/IP server allows the remote access to the device via
a TCP/IP connection.

Note:
An exe file for the cifXTCP/IP server is provided on the product CD
in the Tools directory.

Via the TCP/IP interface of the device or of the remote PC, the device is
configured or diagnosis is performed.
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4.3.5.1 Driver parameters for cifX driver - TCP/IP connection

The settings for the driver parameters for the TCP/IP connection are made
via the netX driver / TCP connection configuration dialog.
Ø Open the TCP connection dialog via navigation area Settings > Driver

> netX driver.
Ê The dialog netX driver is displayed:
Ø Select TCP connection.

Figure 9: netX driver > TCP connection

Parameter Description Range of value /
value

Enable TCP
connector (restart of
ODM required)

checked: The cifX driver can communicate via the TCP/IP interface.
unchecked: The cifX driver cannot communicate via the TCP/IP interface.
If the check mark for Enable TCP connector is set or removed, then the
ODM server must be restarted1, to make the new setting valid.
_______
1 Restart the ODM server via the ODMV3 tray application:

- In the foot line click on  using the right mouse key.
- In the context menu select Service > Start.

checked, 
unchecked; 
Default: 
unchecked

Select IP range Via Select IP range already created IP ranges can be selected.

Via  an additional IP range can be added. 

Via  an IP range can be deleted.
Scan timeout [ms] With Scan timeout can be set, how long to wait for a response while a

connection is established.
10 … 10.000 [ms];
Default: 100 ms

IP range configuration
Disable IP range checked: No connection.

unchecked: The cifX driver tries to establish a connection using the
configured TCP/IP interface.

checked, unchecked
(Default)
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Parameter Description Range of value /
value

IP address (links) Enter the IP address of the device, (if Use IP range is not checked).
Enter the IP address of the device, (if Use IP range is not checked).

valid IP address; 
Default: 192.168.1.1

Use IP range checked: An IP address range is used.
unchecked: Only one IP address is used.

checked, 
unchecked;
Default: unchecked

IP address (right) Enter the end address of the IP scanning range, (only if Use IP range is
checked).

valid IP address; 
Default: 0.0.0.0

Address count Displays the scanning range address count, depending on the selected
IP-start or IP-end address. (For this read the note given below.)

recommended: 10

TCP Port Identifies the endpoint of a logical connection or addresses a specific
endpoint on the device or PC.

0 – 65535; 
Default Hilscher
device: 50111

Send timeout Maximum time before the transfer of the transmission data is canceled if
the send process fails, for example, because of the transfer buffer is full.

100 … 60.000 [ms];
Default (TCP/IP):
1000 ms

Reset timeout Maximum time for a device reset, including the re-initialization of the
physical interface used for the communication.

100 … 99.999 [ms];
Default (TCP/IP): 
20.000 ms

Keep alive timeout The "Keep Alive" mechanism is used to monitor whether the connection
to the device is active. Connection errors are detected using a periodic
heartbeat mechanism. The heartbeat mechanism will be initiated after the
set time has elapsed if the communication has failed.

100 … 60.000 [ms];
Default (TCP/IP):
2000 ms

Restore Resets all settings in the configuration dialog to the default values.
Save Saving all settings made in the configuration dialog cifX driver > TCP/IP

connection, i. e. only for the selected connection type.
Save all Saving all settings made in the configuration dialog cifX driver, i. e. for all

connection types.
Table 10: Parameters netX driver > TCP connection

Note:
Do not use large IP ranges in combination with a low scan timeout.
Microsoft introduced in Windows® XP SP2 a limit of concurrent half-
open outbound TCP/IP connections (connection attempts), to slow
the spread of virus and malware from system to system. This limit
makes it impossible to have more than 10 concurrent half-open
outbound connections. Every further connection attempt is put in a
queue and forced to wait. Due to this limitation, a large IP range
used in combination with a low scan timeout could prevent the
connection establishment to a device.
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4.4 Assigning device (with or without firmware)

Note:
In the Device assignment dialog pane, you first must assign the
PROFINET IO-Controller device to the PROFINET IO-Controller
DTM by checking the check box. This is essential to establish an
online connection from the PROFINET IO-Controller DTM to the
PROFINET IO-Controller device later, as described in section
Connecting/disconnecting device [} page 107].

Therefore, in the Device assignment dialog pane you scan for the
PROFINET IO-Controller device and select it.

If the device did not get a firmware or shall get a new firmware:
1. First you scan for the device (with or without firmware) and select the

device,
2. then you download a firmware to the device, and
3. subsequently you scan for the device (with firmware) once more and select

the device again.
Ø Proceed in the order mentioned.

4.4.1 Scanning for devices
Ø Select Settings > Device assignment in the navigation area.
Ê The dialog pane Device assignment is displayed.
Ø Under Device selection, select suitable only.
Ø Select Scan, to start the scanning process.
ð In the table all devices are displayed, which can be connected to the

PROFINET IO-Controller DTM via the preselected driver.

Figure 10: Device Assignment - detected devices (example: device without firmware)

Note:
For devices, which have been found via the cifX device driver in
the column Access path the indication …\cifX[0toN]_SYS is
displayed. This is correct, as long as a device did not get a
firmware. After the firmware download has been completed, in the
column Access path the indication …\cifX[0toN]_Ch[0to3] is
displayed.
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Parameter Description Range of value /
value

Device selection Selecting suitable only or all devices. suitable only, all
Device *The device name (= name of the device class) of the PROFINET IO-

Controller device appears.
Hardware Port 0/1/2/3 Shows, which hardware is assigned to which communication interface.
Slot number Shows the Slot number (card ID), preset at the PC card cifX via the

Rotary switch slot number (card ID).
The indication n/a means, that no Slot nummer (card ID) exists. This will
occure if the PC card cifX is not equipped with a Rotary switch slot
number (card ID)or for PC cards cifX equipped with a Rotary switch
slot number (card ID) if the rotary switch is set to the value 0 (zero).

1 to 9,
n/a

Serial number Serial number of the device
Driver Name of the driver.
Channel Protocol Shows, which firmware is loaded to which device channel. 

The data for the used channel consists of the protocol class and the
communication class.
a.) For devices without firmware: Undefined Undefined, 
b.) For devices with firmware: Protocol name corresponding to the used
Firmware

Access path 
(last column on the
right)

Depending on the used driver in the column Access path different data to
the device is displayed.
For the cifX device driver the following data is displayed: 
a.) For devices without firmware: …\cifX[0toN]_SYS, 
b.) For devices with firmware: …\cifX[0toN]_Ch[0to3].
cifX[0toN] = Board number 0 to N 
Ch[0to3] = Channel number 0 to 3

Depending on the
device and on the
driver: 
board or channel
number, IP address
or COM interface

Access path 
(at the lower side of
the dialog pane)

If in the table a device is checked, under Access path (at the lower side
of the dialog pane) the driver identification or depending on the used
driver additional data to the device will be displayed.
For the cifX device driver the following data is displayed: 
a.) For devices without firmware: …\cifX[0toN]_SYS, 
b.) For devices with firmware: …\cifX[0toN]_Ch[0to3].
cifX[0toN] = Board number 0 to N
Ch[0to3] = Channel number 0 to 3

Driver identification
(ID)
Depending on the
device and on the
driver: 
board or channel
number, IP address
or COM interface

Table 11: Parameters of the Device Assignment
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4.4.1.1 Selecting suitable only or all devices

All
Ø Under Device selection select all.
Ø Select Scan.

Figure 11: Device Assignment - detected devices (example: device without firmware)

Ê In the table all devices are displayed, which are attainable in the
network and which can be connected to a single DTM each via the
preselected drivers.

Note:
During a subsequent firmware download in the selection window
Select firmware file all files from the selected folder are displayed,
under Files of type „All Files (*.*)“ is displayed and the check box
Validate the selected firmware file. is unchecked.

suitable only
Ø Under Device selection select suitable only.
Ø Select Scan.
Ê In the table all devices are displayed, which can be connected to the

PROFINET IO-Controller DTM via the preselected driver.

Note:
During a subsequent firmware download in the selection window
Select firmware file only firmware files from the selected folder are
displayed, under Files of type „Firmware Files (*.nxm)“ or
„Firmware Files (*.nxf)“ is displayed and the check box Validate the
selected firmware file. is checked.
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4.4.2 Selecting the device (with or without firmware)

Note:
A connection with the PROFINET IO-Controller DTM can only be
established with one PROFINET IO-Controller device.

To select the physical PROFINET IO-Controller device (with or without
firmware):
Ø Check the appropriate device.
Ê Under Access path (below in the dialog pane) the access path to the

device, e. g. the driver identification, or depending on the used driver
additional access data of the device is displayed.

Ø Select Apply, to apply the selection.

Figure 12: Device Assignment - selecting device (example: device without firmware / one
device selected)

Note:
Before an online connection from the PROFINET IO-Controller DTM
to the PROFINET IO-Controller device can be established, a
firmware must be loaded to the device and the device must be
selected once more.

For further information refer to section Selecting and downloading
firmware [} page 37] or to section Selecting the device once more (with
firmware) [} page 35].

4.4.3 Selecting the device once more (with firmware)

Note:
For repeated download this step is omitted.

To select the PROFINET IO-Controller device (with firmware and defined
system channel) once more, proceed as described hereafter:
Ø Under Device selection select all or suitable only.
Ø Select Scan.
Ê For selection All: The table shows all devices which can be reached in

the network and which can be connected to a DTM via the preselected
drivers.
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Ê For selection suitable only: In the table all devices are displayed, which
can be connected to the PROFINET IO-Controller DTM via the
preselected drivers.

Ø Check the appropriate device.
Ø Select Apply, to apply the selection.
Ø Or select OK, to apply the selection and to close the DTM interface

dialog.
Ø Connect the DTM to the device using the context menu (right mouse

click).

Figure 13: Device Assignment - selecting device (example: devices with and without
firmware / one device selected)

Note:
After the firmware download has been completed, for the devices
which have been detected via the cifX Device Driver the following
data is displayed:
In the column Channel protocol: The data for the firmware for the
used channel
In the column Access path or under Access path (below in the
dialog pane): The data: …\cifX[0toN]_Ch[0to3].
cifX[0toN] = board number 0 to N
Ch[0to3] = channel number 0 to 3

For further information how to establish an online connection from the
PROFINET IO-Controller DTM to the PROFINET IO-Controller device, refer
to section Connecting/disconnecting device [} page 107].
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4.5 Selecting and downloading firmware

Requirements

Note:
Before downloading the firmware, you must select the driver and
the master device (with or without firmware) and assign the
hardware to the device. For more information, see sections on
driver settings and device assignment.

How to proceed

You can use the dialog Firmware download to transfer a firmware to the
device. Load the firmware into the device as described below:

1. Select the firmware file.
Ø In the navigation area, select Settings > Firmware download
Ê The dialog pane Firmware download is displayed.

Figure 14: Firmware download

Element Description
Name The path and name of the selected firmware file are displayed.
Version The version and build version of the selected firmware file are displayed.
Browse… Via "Browse..." you can select the firmware file to download.

Note! If the device is not assigned to the hardware, the error message "The
device is not assigned to the hardware!" is displayed.

Download Via "Download" you can download the firmware to the device.
Table 12: Firmware download parameters

Ø Select Browse....
Ê If the device is not assigned to the hardware, the error message "The

device is not assigned to the hardware!" is displayed.

DTM for Hilscher PROFINET IO-Controller devices (RT/IRT) | Configuration of contoller devices
DOC150704OI08EN | Revision 8 | English | 2023-07 | Released | Public

© Hilscher 2015 – 2023



Settings 38/164

Figure 15: Error Message "The device is not assigned to the hardware!"

Ø Click OK and select and assign the master device as described in
section Assigning device (with or without firmware) [} page 32].

Ê If a hardware has been assigned to the device, the selection window
Select firmware file opens.

Ø Enlarge the selection window to view the columns Hardware and
Version.

Figure 16: "Select firmware file" selection window (example CIFX)
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Parameter Description Range of value /
value

Column Name File name of the firmware file
To sort the entries of the window Select firmware file by name click to

the column head .

nxf, nxm

Column Firmware Name of the firmware (consisting of the protocol name and the protocol
class)

Column Hardware Device class of the assigned hardware e. g. CIFX, 
COMX, COMX 51, 
NETJACK 10, 
NETJACK 50, 
NETJACK 51, 
NETJACK 100,
NETTAP 50
(Gateway),
NETTAP 100
(Gateway),
NETBRICK 100
(Gateway)

Column Version Firmware version x.x (build x)
Tooltip To view the tooltip display, move the mouse pointer over the selected

firmware line.

File of Type "All Files (*.*)" if before in the Device assignment pane the list entry all
was selected.
"Firmware Files (*.nxm)" or "Firmware Files (*.nxf)" if before in the Device
assignment pane under Device selection - suitable only was selected.

All Files (*.*),
Firmware Files
(*.nxm),
Firmware Files
(*.nxf)

Recent folders Path of the recently opened folder
Firmware As soon as the firmware file has been selected, under Firmware the

name, the version and the build version as well as the device class for the
selected firmware is displayed.

Name, Version,
Build Version,
Device Class for the
selected firmware

Help Button to open the online help of the DTM.
Table 13: Parameters “Select firmware file”

Further descriptions to the selection window Select firmware file
are included in the context sensitive help (F1 key) of the Microsoft
Corporation.

Note:
After in the Device assignment pane under Device selection - all
or suitable only has been set, during a subsequent firmware
download in the selection window Select firmware file the following
data is displayed or set:
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(for the list box entry ->) all suitable only
In the selection window Select
firmware file:

all files from the selected
folder

only firmware files from the
selected folder

Under File of type*: "All Files (*.*)" "Firmware files (*.nxm)",
"Firmware Files (*.nxf)"

Validation: A restricted validation will
be performed if the
selected firmware is
applied for the download.

A validation is made whether
the firmware file is suitable
for the PROFINET IO-
Controller DTM.

These settings in the selection window Select firmware file can also be changed
manually.

Table 14: In the selection window "Select firmware file"

Ø In the selection window mark the firmware file to be loaded using the
mouse.

Ê In the selection window under Firmware the name and the version of
the firmware are displayed.

Ø In the selection window select the Open button.
Ê A validation is made, whether the selected firmware file is suitable for

the PROFINET IO-Controller device.
Ê If a firmware file has been selected that is valid for the selected device,

the selection window closes immediately (without dialog).
Ê If a firmware file has been selected that is not valid for the selected

device, the query Select firmware file appears:
"Invalid firmware for assigned device! 
[detailed explanation]
Should the firmware file nevertheless be applied for the download?"

Figure 17: Request Select firmware file - Example Invalid Firmware
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 Invalid firmware

Loading invalid firmware files could render your device unusable.
Ø Only proceed with a firmware version valid for your device.
Ø Answer to the request with No and select a valid firmware.
Ê The selection window closes.

2. Transmit firmware to the device.
Ø Note the following safety information:

 Communication stop caused by firmware update, faulty
system operation possible, overwriting of firmware or loss of device
parameters

Before you initiate a firmware download process, while the bus is still in
operation status:
Ø Stop the application program.
Ø Make sure that all network devices are in a fail-safe condition.

 Firmware corruption or loss of parameters caused by
power disconnect during firmware download
Ø During firmware download process, do not interrupt the power supply to

the PC or to the device, and do not perform a reset to the device!
Ø In the dialog pane Firmware download click to the Download button,

to download the firmware.
Ê The request Do you really want to download the firmware? is

displayed.

Figure 18: Request - Do you really want to download the firmware?

Ø Click Yes.
Ø If you are sure, that you have selected the appropriate firmware file

answer to the request with Yes otherwise with No.
Ê During the download, a progress bar is displayed ("Download active,

device performs initialization…"), in the status line a clock / green hook
symbol is displayed and in the dialog pane Firmware download the
button Download is grayed out.

Ê In the Firmware download dialog pane the path and name as well as
the version of the selected firmware file are displayed.
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Figure 19: Firmware download - progress bar

Figure 20: Clock symbol and hook symbol green

Figure 21: Firmware download - download
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4.6 Licensing
To open the Licensing pane:
Ø In the navigation area select Settings > Licensing.
Ê The dialog pane Licensing is displayed.

Figure 22: Licensing

Using the license dialog, you can order licenses for Master protocols and
Utilities and transfer them to your device. Further information on the
license dialog is described in the section Licensing [} page 57].
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4.7 Ethernet devices
In the Ethernet devices dialog you can set the device name or IP
address for Ethernet-enabled devices. The device name must match to the
PROFINET IO specification [3] for the “Name of Station”.

Alternatively a Device name or IP address an can be used that was set in
the configuration under Configuration > Device table > Name of station
or under Configuration > IP address table > IP address for a different
device.

For more information, see the section Device table [} page 74] and
the section IP address table [} page 76]

The identification of devices is done via the DCP protocol, which is
supported by PROFINET compatible devices.

4.7.1 Overview Ethernet devices
Ø Select Settings > Ethernet devices.

Figure 23: Ethernet devices pane (example)
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In the dialog pane Ethernet devices you can:
1. Select network devices

Under Use network connections for scan (A) the network devices at
the PC are displayed. Here you must select the network devices at the
PC are to be used at the scan.

2. Search and select devices
Under Devices online (B) the devices are displayed, which are found in
the Ethernet network connected to the PC via the DCP protocol. The
device to be configured must be selected here.

3. Configure devices
The selected device is to be configured in the area below (C). Therefore
the configuration for the device can be perfomed here or a configuration
of another device can be used.

4.7.2 Selecting network devices for scan

Note:
Using the DCP protocol to scan for devices, the network devices to
be used for the scan must be selected manually.

Under Use network connections for scan the network devices at the PC
are displayed.

Figure 24: Ethernet Devices pane - Selection of the Ethernet connection (example)

Here you must select the network devices to be used at the scan via the
DCP protocol.
Ø Under Device (1) check the network devices to be used with the DCP

protocol at the scan.
ð Under Device (2) the name and under Port (3) the port number of the

network devices of your PC are displayed.

DTM for Hilscher PROFINET IO-Controller devices (RT/IRT) | Configuration of contoller devices
DOC150704OI08EN | Revision 8 | English | 2023-07 | Released | Public

© Hilscher 2015 – 2023



Settings 46/164

4.7.3 Searching and selecting devices
Ø To find devices, Devices online> Search devices (refer to position

(12) in the following figure).
ð The Ethernet network connected to the PC is scanned for devices that

respond to the DCP protocol. If devices are found, they are listed as
follows:

Figure 25: Ethernet devices pane - Searching and selecting devices (example)

Refer to the table in the figure above for the following information:
Name Position

in figure
Description Value/range of

values
MAC addresse (4) The MAC address (=MAC-ID) is the unique (physical) Ethernet

address of the device assigned by the manufacturer on delivery.
Device type (5) Name for the device stored in the device in a non-volatile fashion.
Device name (6) Device name that can be set in the Ethernet devices pane.

The device name must comply with the specifications of the
PROFINET IO specification [3] for the name of station.

Character string, 
1 ... 240 characters

IP addresse (7) The IP address of the device can be set in the Ethernet device
pane.
The IP address must be unique and match the network being
used. The IP address 0.0.0.0 indicates that no IP address has
been set yet.

Valid IP address

Protocol (8) Protocol by which the device was found. DCP
Device ID (9) Identification number of the device, 

is defined uniquely by the manufacturer for each device.
0x00000000 ...
0xFFFFFFFF (hex)

Vendor ID (10) Identification number of the manufacturer, assigned by the
PROFIBUS Nutzerorganisation e.V.

0x00000000 ...
0xFFFFFFFF (hex)

Device role (11) Textual description of the function of the device in the network. "Device", "Controller",
"Multidevice",
"Supervisor"

Table 15: Parameters of found devices
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4.7.3.1 Search device within table

How to proceed:
Ø Put in the string to be searched at Find (1).

If the table is large, you can search the table for any string within a column.

Figure 26: Ethernet Devices pane - Search device in the table (example)

· Using Next (2), the next entry (search direction down) is found in the
table that corresponds to the search string.

· previous (3) searches the table for the next entry (search direction up)
that corresponds to the search criterion.

Sorting the table

By clicking on a field in the header of the table, you can sort the rows by the
entries in the column, ascending alphanumeric ascending or descending.

4.7.3.2 Selecting device
Ø To select a device to be configured click the corresponding line in the

table Devices online.

Figure 27: Ethernet devices pane - selecting device (example)
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4.7.4 Configuring device
Using the DCP protocol you can newly assign the Device name or the IP
address of a device or you can change an already configured device name
or IP address. For configuring a device there are the two possibilities:
· The configuration for the device can be created newly.
· Alternatively a configuration already existing can be used, which has

been created / set at another place in the configuration software for
another device.

4.7.4.1 Overview on configuration

To configure Ethernet-capable devices when using the DCP protocol, the
Ethernet devices dialog provides the following options:

Figure 28: Ethernet Devices pane - Overview on configuration (example)

· Under Use configuration of (1) you can specify whether the
configuration for a device should be created again or whether a
configuration should be applied that has already been made / set for
another device in the configuration software at another location.

· Under Set name (2), the device name read out can be displayed and, if
necessary, changed or set here again. The device name must comply
with the specifications of the PROFINET IO specification [3] for the
name of station.

· Under Set IP address (3), the IP address can be set or changed.
· Other functions (4) include for Ethernet capable devices the

configuration options Signal and Reset to factory defaults.

Note:
For PROFINET IO-Controller devices, it is possible that they reject
a change in the device name or IP address. In this case, an error
message appears.
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4.7.4.2 Creating new configuration or using from device

Important:
In order for a configuration that has been made elsewhere in the
configuration software for a PROFINET IO device (Controller or
Device) to be applied to another device, the already configured
PROFINET IO-Device in the FDT container (in this case netDevice)
must be configured as a PROFINET IO DTM.

Under Use configuration of, you can specify whether
· the configuration for a device must be recreated,
· or for the configuration of a device, a configuration is to be applied that

was made elsewhere in the configuration software for another device.
This existing configuration can be used for the selected device and
must be sent to this device.

How to proceed

If you want to recreate the configuration:

Figure 29: Ethernet Devices pane - Use configuration of (example)

Ø Uncheck Use configuration of (1).
Ø Alternatively, check Use configuration of (1) if you want to apply a

configuration that has already been created.
Ø Select the device (2) whose configuration is to be applied to the new

device to be configured.
Ø Then configure the device name and IP address as described below.
Ø When finished, click Devices online> Search devices again.
ð Only now the values that have been applied are displayed as current

values.
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4.7.4.3 Creating new configuration / Setting new device name

Note:
The device name must comply with the PROFINET IO specification
[3]. Forbidden signs (e. g. blanks) must not be used in the name.

How to proceed

Figure 30: Ethernet Devices pane - setting new device name (example)

Ø Do notcheck Use configuration of (1).
Ø Click the Set name (3) tab.
Ê For the PROFINET IO device (Controller or Device): The current device

name is displayed under Device name (4).
Ø To New device name (5) type a new device name according to the

PROFINET IO specification [3].

To set the device name "temporary" or "permanent":
Ø Check temporary (6) if the device name is to be saved only temporarily

(as far as the used device supports this functionality).
Ø Or do not check temporary (6) if the device name should be set

permanently (if the device supports this choice).

Set Device Name:
Ø Click Set name (7).

The new device name will be transferred to the used device.
Ø Click Devices online > Search devices once more.
ð The newly set device name is displayed under Device name (4) as the

current device name.

Note:
For PROFINET IO-Controller devices a change of the device name
can be rejected. Then an error message is displayed.
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4.7.4.4 Device name according to PROFINET „Name of station“ specification

The device name must match the specifications in the following extract
from the PROFINET IO specification [3] for the "Name of Station".

A Name of station:
· has a length of 1 ... 240 characters.
· may consist of one or more labels, which are 1 ... 63 characters long

and which are separated by dots.
· must contain only valid characters: 

a – z lower case letters, 
0 – 9 digits, 
-Minus sign, 
. Point. 
The point is the separator between labels. 
The minus sign must not be used as the start or end character. 
The minus sign must not be used before or after a dot. 
The Name of Station must not begin or end with a point. 
Invalid characters are, for example, capital letters, underline and
spaces.

Source [3] (see section References [} page 147]): PNO document 2722,
section 4.3.1.4.15.1, on page 10073f.

4.7.4.5 Use configuration / Use device name

How to proceed

Figure 31: Ethernet Devices pane - Use name of station (example)

Ø Uncheck Use configuration of (1).
Ø Select the device (2) whose configuration will be used for the device to

be configured newly.
Ø Click the Set name (3) tab.
Ê For the PROFINET IO device (Controller or Device): The current device

name is displayed under Device name (4).
Ê Under New device name (5) the device name is displayed that was

already entered in the configuration software as the „Name of Station“.
This one must not be entered again, but can be sent as a new device
name to the used device.
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To set the device name "temporary" or "permanent":
Ø Check temporary (6) if the device name is to be saved only temporarily

(as far as the used device supports this functionality).
Ø Or do not check temporary if the device name should be set

permanently (if the device supports this choice).

Set Device Name:
Ø Click Set name (7).
Ø The device name to be used will be transferred to the used device and

is displayed under Device name (4) as the current device name.
Ø Click Devices online > Search devices once more.
ð The used device name is displayed under Device name as the current

device name.

Note:
For PROFINET IO-Controller devices a change of the device name
can be rejected. Then an error message is displayed.

4.7.4.6 Creating new configuration / setting new IP address

The IP address is set statically during configuration. Later, the PROFINET
IO-Controller assigns an IP address to the device via the name of station. If
the device used supports the assignment of the IP address via a DHCP
server (if available), you can choose between the static IP address
assignment and the IP address transfer from a DHCP server.

How to proceed
Ø Do not check Use configuration of (1).
Ø Click the Set IP address (3) tab.

Figure 32: Ethernet Devices - Reset IP Address pane (example)

Ø Select Use static IP address (4) (default setting).
Ø Or select Get IP Address via DHCP (11).
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If Use static IP address was selected, proceed as follows:

For the PROFINET IO device (Controller or Device):
Ø Under IP address (5), enter the IP address.
Ø Under Subnet mask (6), enter the subnet mask.
Ø Under Gateway (7), enter the gateway address.

Figure 33: Ethernet Devices pane – Enter new IP address, subnet mask, and gateway
address

If Get IP address via DHCP is selected, proceed as follows:
Ø The area to specify the static IP address is grayed out.
Ø Under Authentication method (12), select how the device is to be

identified, via MAC address, Name of Station or Client ID.
Ø For the Client ID authentication method: set the Client ID under Client

ID (13).

For both options (Use static IP Address or Get IP address via DHCP),
proceed as follows:
Ø To set the IP address, subnet mask and gateway address "temporary"

or "permanent", check Store settings temporary (14).

Note:
If the IP address, subnet mask and gateway address are set
"temporarily", the settings made are no longer stored in the device
after a device reset.

Ø Or do not check Store settings temporary (14), to permanently set the
IP address, subnet mask, and gateway address (if the device supports
this selection).

Note:
The PROFINET IO-Controller can assign a new IP address to the
PROFINET IO-Device when the PROFINET network starts up.

Set address:
Ø Click Set address (15).
Ê The newly created IP address, subnet mask, and gateway address are

transferred to the device in use. The transmission may take up to 40
seconds depending on the device.

Ø Click Devices online > Search devices again.
Ê The current IP address, subnet mask and gateway address are

displayed under Current IP address (8), Current subnet mask (9) or
Current gateway (10).
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Figure 34: Ethernet Devices pane - displays new current IP address, subnet mask, and
gateway address

Note:
For PROFINET IO-Controller devices, it is possible that they reject
a change in the IP address. In this case, an error message appears.

4.7.4.7 Use configuration / Use IP address

The IP address is set statically during configuration. Later, the PROFINET
IO-Controller assigns an IP address to the device via the name of station. If
the device you are using supports IP address assignment via a DHCP
server (if available), you can choose between static IP address assignment
and IP address assignment from a DHCP server.

How to proceed
Ø Check Use configuration of (1).
Ø Select the device (2) whose configuration is to be applied to the new

device to be configured.
Ø Click the Set IP address tab (3).

Figure 35: Ethernet Devices pane - apply IP Address (example)

Ø Select Use static IP address (4) (default setting). Or select Get IP
address via DHCP (11).

If Use static IP address was selected, proceed as follows:
Ø For the PROFINET IO device (Controller or Device) under IP address

(5), Subnet mask (6) or Gateway (7), the IP address, subnet mask and
gateway address to be applied are displayed that have already been
entered in the configuration software. They do not need to be re-
entered, but can be sent to the device being used as a new IP address,
subnet mask, and gateway address.
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If Get IP address via DHCP is selected, proceed as follows:

The area to specify the static IP address is grayed out.
Ø Under Authentication (12) method, select how to identify the device,

by MAC Address, Name of Station , or Client ID.
Ø For the Client ID authentication method, enter the Client ID under Client

ID (13).

For both options (Use static IP address or Get IP address via DHCP),
proceed as follows:
Ø To set the IP address, the subnet mask and the gateway address

"temporarily" or "permanent", check Store settings temporary (14).

Note:
If the IP address, subnet mask and gateway address are set
"temporarily", the settings made are no longer stored in the device
after a device reset.

Ø Or do not check Store settings temporary (14), to permanently set the
IP address, subnet mask, and gateway address (if the device supports
this selection).

Note:
The PROFINET IO-Controller can assign a new IP address to the
PROFINET IO-Device when the PROFINET network starts up.

Set address:
Ø Click Set Address (15).
Ê The IP address, subnet mask, and gateway address to be applied are

transmitted to the device being used. The transmission may take up to
40 seconds depending on the device.

Ø Click Devices online > Search devices again.
ð The new current values are displayed under Current IP address (8),

Current subnet mask (9) or Current gateway (10).

Figure 36: Ethernet Devices pane - displays new current IP address, subnet mask, and
gateway address

Note:
For PROFINET IO-Controller devices, it is possible that they reject
a change of the IP address. In this case, an error message appears.
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4.7.4.8 Signal, factory defaults

The tab Other Functions provides the functions Signal and Reset to
factory defaults.

How to proceed
Ø Do not check Use configuration of (1).
Ø Click Other functions (2).

Figure 37: Ethernet Devices pane - Signal, factory defaults (example)

For the PROFINET IO device (Controller or Device):
Ø Click Signal (3).
Ê The LED on the selected device blinks. This allows to clearly identifying

the device among others.
Ø Click Reset to factory defaults (4).
ð Adjustments made at the device are reset to the factory default.
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5 Licensing
Using the license dialog, you can order licenses for Master protocols and
Utilities and transfer them to your device.

5.1 Opening license dialog
You first open the License window.

Note:
You first need to assign the master device to the DTM. Only then
the device data and the licenses already present in the device are
displayed in the License dialog.

How to proceed:
1. Assign the master device to the DTM.

Ø In the FDT container netDevice, double click to the device icon.
Ø Select Settings> Driver.
Ø Select one or several drivers (checking).
Ø Select Settings > Driver > [Name of the assigned driver].
Ø Configure the driver settings if necessary.
Ø Select Settings > Device assignment.
Ø Under Device selection, select suitable only or all and click Scan.
Ø In the table, check the required device.
Ø Click Apply.
Ø Close the DTM configuration dialog via OK.

For details to the device assignment, refer to section Settings [} page 22].
2. Open the License pane.

Ø Right-click on the device icon in the FDT container netDevice.
Ø From the context menu, select Additional functions> License.
ð The License window opens.
ð The title bar contains the notation of the device description: Symbolic

Name [Device Description] <Station Address > (#Network ID).
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5.2 License dialog
In the License pane, you can:
· check, which licenses for Master protocols or Utilities are present in the

device (Position (1) in the figure below),
· order licenses (Positions (2) to (11)),
· transfer license to the device (12),

Figure 38: License pane

Note:
To display further entries under License Type, move the scroll box
(a) downwards or upwards. To display further entries under
Request form, please fill out, move the scroll box (b) downwards
or upwards.
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5.3 Which licenses are present in the device?
Check, which licenses are present in the device.

How to proceed:
Ø Open the License pane as described under section Opening license

dialog [} page 57].

Figure 39: License pane - License Type

Ø Under License type click  at Master protocols.
Ê The Master protocols overview opens:

Figure 40: License pane – License Type / Master protocols

Ø Or click  at Utilities.
Ê The Utilities overview opens:

Figure 41: License pane – License Type / Utilities

Ê The column Existing indicates which licenses are present in the device.

Yes = License is present in the device.

No = License is not present in the device.

Note:
In newer versions of the present configuration software, under
License type may be displayed additional licenses or other
protocols that can be ordered later.
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5.3.1 License for master protocols
One General Master License:

On the device maximally 1 communication protocol with master function
can be implemented.

Two General Master Licenses:

On the device maximally 2 communication protocols with master function
can be implemented.

The license includes the following master protocols:
· AS-Interface Master
· CANopen Master
· DeviceNet Master
· EtherCat Master
· EtherNet/IP Scanner
· PROFIBUS Master
· PROFINET IO RT Controller
· Sercos Master

5.3.2 Licenses for utilities
SYCON.net

OPC Server

QVis Minimum Size
· QVis Standard Size
· QVis Maximum Size
· CoDeSys Minimum Size
· CoDeSys Standard Size
· CoDeSys Maximum Size

For the Utilities QVis and CoDeSys only one license can be selected
alternatively:
· Minimum Size,
· Standard Size or
· Maximum Size.
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5.4 How to order a license?
To order a license, proceed as follows:

1. Open the license dialog.
Ø Refer to Section Opening license dialog [} page 57].

2. Select the required licenses.
Ø Refer to Section Selecting license(s) [} page 61].

3. Enter the ordering data.
Ø Refer to Section Ordering data [} page 62].

4. Place your order.
Ø Refer to Section Ordering the license [} page 64].

5.5 Selecting license(s)
You can select licenses for Master protocols and / or Utilities.

1. Selecting license(s) for Master protocol(s):
Ø In the License pane under License type click  at Master protocols.
Ø Under Order check as many licenses must run simultaneously on your

device: 
One General Master License or 
Two General Master Licenses.

2. And/or select license(s) for utility(utilities):
Ø In the License pane under License type click  at Utilities.
Ø Under Order check the required utility(utilities) 

(single or several):
· SYCON.net
· OPC Server
· QVis Minimum Size*
· QVis Standard Size*
· QVis Maximum Size*
· CoDeSys Minimum Size**
· CoDeSys Standard Size**
· CoDeSys Maximum Size**

For *) and **) minimum size, standard size or maximum size can be
selected only as an alternative.
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5.6 Ordering data
· Device information

The "Device Information" required for the order are read from the device
and automatically filled in the order.
· Ordering Data
Ø Enter the Ordering Data into the License pane.
Ø Enter the Data to manage the Order (therefore refer to section Data to

manage the order (license information) [} page 63]).

5.6.1 Device information (ordering data read from the device)
The following ordering data is read from the device and displayed in the
License pane:
· Manufacturer
· Article number
· Serial number
· Chip type
· Step (chip revision)
· Romcode revision
· Checksum (checksum of the device data)

The gray fields under Request Form, please fill out > Value contain the
ordering data read from the device:

Figure 42: License pane - request form, please fill out / device information

These ordering data read out from the device are displayed automatically
from the device.
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5.6.2 Data to manage the order (license information)
For your order, you must enter the following data to the License pane:
· License type (User Single Device License).

Figure 43: License pane - Request form, please fill out / License type

Ø Select the license type under Request form, please fill out > Value,
(for future application, currently only User Single Device License can be
selected).

· Mandatory data to the order request (editable fields):
– First name
– Surname
– E Mail (address, to which the license download link shall be send.)
– Telephone
– Company
– Address
– Country
– City, State, Zip

Figure 44: License pane - request form, please fill out / mandatory data

Ø Enter all mandatory fields under Request form, please fill out > Value
(marked with*).

· Additional order data, not mandatory (editable fields):
– Fax
– Customer number
– Order number
– Value added tax identification number

Ø Under Request form, please fill out > Value enter all fields for the
additional data, which is not mandatory.
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5.7 Ordering the license
Place your order in the License pane. Therefore:

Figure 45: License pane – selecting the subsidiary / ordering / contacts

Ø Select the subsidiary (4), to which the order shall be send.
Ø Place the order:
· by E-Mail (5),
· or by Fax (6) or by Telephone (7),
· or in a file (8).

The Contact data of the selected subsidiary is displayed under the
positions (9), (10) and (11).
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5.7.1 Ordering the license by e-mail
You can place your order by e-mail.
Ø In the License pane, click e-mail… (5).
Ê The order e-mail License request opens:

Figure 46: Example: Order e-mail License request

The order e-mail License request contains:
· the E-mail… of the selected subsidiary (a),
· the automatically generated XML file (b) EmailOrderRequest_-

[Devicenumber]_[Serialnumber].xml with a summary info of the order
information,

· the Order address (c),
· the License information (d),
· the License type (e),
· the Device information (f),
· the ordered licenses (g).
Ø Send the order e-mail License request.
ð The order process is complete.
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5.7.2 Ordering the license by fax or by telephone
You can place your order by fax or by telephone.
Ø In the License pane, click Print fax form (6) or Telephone… (7).
Ê The summary of the ordering data PrintOrderRequest_[Devicenum-

ber]_[Serialnumber].html is opened in a browser window.

Note:
If your browser does not display the order data or the window Move
element or Copy element is displayed, check the safety settings of
your system.

Figure 47: Example: Order data form PrintOrderRequest
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The order data form contains:
· the Order address (c) ,
· the License information (c),
· the License type (e),
· the Device information (f),
· the ordered Licenses (g).
Ø Print the order data form, sign it and send it by fax.
Ø In the License pane, use the Fax number (10), which is displayed after

the subsidiary, was selected.

Or:
Ø Keep ready the data form and communicate the order data via

telephone.
Ø In the License pane, use the telephone number (11), which is displayed

after the subsidiary, was selected.
ð The order process is complete.

5.7.3 Exporting license request to a file
If you are working on a process computer without an e-mail client, you can
export your order information to a file, save the file to a removable disk and
place your order manually via e-mail from a different PC.
Ø In the License pane, click Export license request… (8).
Ê The window Browse for folder is displayed.
Ø Choose for or create a new folder on a removable disk.
Ø Save the automatically generated XML file EmailOrderRequest_-

[Devicenumber]_[Serialnumber].xml with a summary info of the order
information to this folder.

Ø Send this file from a PC with an e-mail client manually via e-mail.
Ø Therefore use an e-mail address, which is displayed after the subsidiary

was selected in the License pane (see Position (9), figure License
pane [} page 58]).

ð The order process is complete.
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5.8 How to get the license and transfer it to the device

Note:
License files can only be delivered via e-mail. The e-mail contains a
link to download the license file.

According to the license you ordered, you will receive an e-mail containing
a Link to download the license file. This leads to a server PC on which
the license file is provided. Using the received link you will have to save the
license file on your PC and then transfer the license to your device. If your
e-mail client is on another PC as your device, you must save your license
file e. g. to an USB stick.

Steps on how to proceed
1. Save the license file to a PC or a disk.

Ø Click to the Link to download the license file in the e-mail.
Ø Save the license file *.nxl to a PC or a removable disk.

2. Download the license file to the device.
Ø Respectively connect the removable disk with the license file to the PC,

which is connected to your device.
Ø In the License pane, click Download license (12) in the License pane

in the configuration software.
Ê The file selection window Open is displayed.
Ø Therein select the license file netX License Files (*.nxl).
Ø Click Open.
Ê The license file is transferred to the device.
Ê After this the license is present in the device and is activated with the

next device reset.

Note:
To activate the license in the device for the first time, a device reset
is required.

3. Activate device reset
Ø To check whether the license has been activated, follow the steps in

section Which licenses are present in the device? [} page 59].
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6 Configuration

6.1 Overview configuring device parameters
Under "Configuration" you can configure the configuration for your device.
· The Controller network settings include the current name of station of

the PROFINET IO-Controller, as well as the description and the IP
settings.

· The Device table dialog pane shows all PROFINET IO-Devices that are
available in the PROFINET IO-Controller configuration.

· The IP address table dialog pane displays the name of station and the
IP settings for PROFINET IO-Devices connected to the PROFINET IO-
Controller.

· The dialog pane Process data serves as an external process data
interface for the PROFINET IO-Controller DTM.

· In the Isochronous modules dialog pane, IRT-enabled (isochronous)
devices and modules, or isochronously supported submodules, are
displayed that have the isochronous mode.

· The Address table shows a list of all addresses used in the process
image memory.

· The FSU/port settings dialog pane is used in the PROFINET IO-
Controller to set whether a PROFINET IO-Device should establish a
connection via fast-start-up for cyclic user data exchange.

· The Station timing dialog pane shows the timing of the station.
· At the Controller settings pane, device related settings can be made.

Figure 48: Navigation area - Configuration

Note:
To edit the dialog panes under Configuration, you need the user
rights for "Maintenance".
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For further information about the configuration, see sections.
· Controller network settings [} page 71],
· Device table [} page 74],
· IP address table [} page 76],
· Process data [} page 78],
· Isochronous modules [} page 79],
· Address table [} page 82],
· FSU/port settings [} page 85]
· Stations timing [} page 87] and
· Controller settings [} page 104].

6.2 Configuring IRT communication
To configure devices for the isochronous real-time communication (IRT)
· the configuration of the Stations timing settings in the PROFINET IO-

Controller DTM for IRT is required. For this, the sync domain settings
must be made for IRT-capable PROFINET IO-Devices. For more
information, see section Stations timing [} page 87].

· Furthermore the planning and configuration of the device topology and
the configuration of the properties of the device, port and connection
must be done in the Topology editor.

For information concerning the configuration of the topology of
devices in domains for isochronous real-time communication (IRT),
refer to the Operating instruction manual Topology editor.
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6.3 Controller network settings
The Controller network settings dialog pane shows the current Name of
station and the IP settings of the PROFINET IO-Controller, which can be
changed here.

By using the Accept DCP set via network option, the controller network
settings can be set via the DCP protocol (if necessary by using an external
tool). By using the Overwrite name of station of devices based on
topology information option, station names can be subsequently
assigned to devices.
Ø Select Configuration > Controller network settings in the navigation

area.
ð The Controller network settings pane is displayed.

Figure 49: Configuration > Controller network settings

Parameter Description Range of value /
value

Name of station Network name of the PROFINET IO-Controller station (editable).

The Name of station must be DNS compatible. For further information,
see section Device name according to PROFINET „Name of station“
specification [} page 51]. Invalid entries will display a red exclamation
point and an error message.
The name of station of the PROFINET IO-Controller station can also be
edited in the 'Topology editor' under ‚Device properties‘.
For information on the permitted signs, see section Name
encoding [} page 149].

Name according to
the PROFINET
specification 
(PNO document
2722)
1 - 240 characters

Description Symbolic name of the PROFINET IO-Controller DTM (editable). Character string
Device type name Name of the physical PROFINET IO Controller device. This is a non-

volatile stored name for the PROFINET IO Controller device in the
PROFINET IO Controller device, which is shown here only.

Character string
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Parameter Description Range of value /
value

Accept DCP set via
network

Case 1: If Accept DCP set via network is checked, the settings for the
name of station and the IP settings of the PROFINET IO-Controller device
are made via the DCP protocol. This can be done in the Ethernet
devices pane (see section Ethernet devices [} page 44]), or via an
external tool that can send DCP commands. 
When a DCP command is sent in case 1 , any settings made in the
Controller network settings pane are overwritten.
Important! The name of station and the IP settings of the PROFINET IO-
Controller device can only be set using the DCP protocol if the
PROFINET IO-Controller device is in the ‚NetworkUp‘ operating state.
If the name of station is set using an external tool ("Name baptism" for
PROFINET devices), it must be synchronized manually with the device.
This means that the "name baptism" is not performed via the
configuration download in the configuration software SYCON.net.
Case 2: If Accept DCP set via network is unchecked, the settings made
in the Controller Network Settings pane for the name of station and IP
settings will be used. 
In case 2 , the name of station and the IP settings cannot be set in the
Ethernet devices pane or these settings are rejected by the PROFINET
IO-Controller.

checked, unchecked
, default: unchecked

IP settings of the PROFINET IO-Controller station (editable)
IP address IP address of the PROFINET IO-Controller station. Valid IP address

Network mask Network mask of the PROFINET IO-Controller station. Valid network mask

Gateway address Gateway address of the PROFINET IO-Controller station. Valid gateway
address

Device settings
Overwrite name of
station of devices
based on topology
information

The option Overwrite name of station of devices based on topology
information can be used to assign a name of station from the PROFINET
IO-Controller device to a PROFINET IO-Device. Names for devices are
subsequently assigned in the Device table pane (see section Device
table [} page 74]) in the Name of station column.
The prerequisite for using the option is that the corresponding topology
information is available in the firmware for the PROFINET IO-Device.
These are set in the Topology editor. This means that a connection to the
device must be configured in the Topology editor. For more information
on connecting devices in the Topology editor, refer to the operation
instruction manual Topology Editor.
Effect of this option:
If the PROFINET IO-Controller firmware does not find a PROFINET IO-
Device in the network under the name of station specified in the Device
table pane, the PROFINET IO-Controller device will address the
PROFINET IO-Device via topology information.
If the PROFINET IO-Controller device then finds a PROFINET IO-Device
that is located at the position in the topology, there are two options:
1) Overwrite name of station of devices based on topology
information is checked: In this case, the PROFINET IO-Controller device
will perform the "name baptism", even if the device found already has a
name of station.
2) Overwrite name of station of devices based on topology
information is unchecked: In this case, the PROFINET IO-Controller
device will perform the "name baptism", provided that the PROFINET IO-
Device does not have a name of station at all. An incorrect name of
station name of station has no consequences.

checked, unchecked
, default: unchecked

Table 16: Parameters of the controller network settings dialog pane

Ø Set the name of station and the IP settings for the PROFINET IO-
Controller.
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Ø Check DCP set is activated via the network if the settings for the
Name of Station and the IP settings are to be made via the DCP
protocol (if necessary via an external tool).

Important:
The Name of Station and the IP settings of the PROFINET IO-
Controller device can be set via the DCP protocol only if the
PROFINET IO-Controller device is in operating mode ‘Network Up’.

Ø Check Overwrite name of station of devices based on topology
information if name of station settings are to be set to devices
subsequently.
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6.4 Device table
The Device table dialog pane shows the list of all PROFINET IO-Devices
configured in the PROFINET IO-Controller configuration.

Follow the steps described hereafter:

1. Activate the required device/s:
Ø Select Configuration > Device table in the navigation area.
Ø Select the required device/s.
Ø In the column Activate check the corresponding checkbox.

2. Set the Name of station of the PROFINET IO-Device station.

Note:
The Name of station displayed here must match with the name of
station stored in the PROFINET IO-Device. The name of station
must be explicit in the PROFINET network. It must be a DNS
compatible name.

Ø In the column, Name of station set the network name of the
PROFINET IO-Device station.

Figure 50: Configuration > Device Table

*The name of the PROFINET IO-Device appears.
Parameter Description Range of value /

value
Activate If Activate is checked, process memory in the controller is reserved for

this device and the controller makes a data exchange on the bus to this
device.
If Activate is deactivated, the controller reserves memory in the process
data image for this device, but no data exchange to this device is made
on the bus.

Default: checked
Checked,
unchecked

Index Via the index (editable) you can define an user-defined sequence for the
devices configured in the PROFINET IO-Controller.

1 … n

Name of station Network name of the PROFINET IO-Device station (editable).
The name of station is set here. In the PROFINET IO-Device-DTM device
it is only displayed or otherwise it must be set directly in the configuration
tool of the PROFINET IO-Device.
The name of station set here must match with the name of station set in
the PROFINET IO-Device. The PROFINET IO-Controller uses the name
of station to identify the PROFINET IO-Device via the PROFINET network
and to build up communication.
The name of station must be explicit in the PROFINET network. It must
be a DNS compatible name. For further information refer to section
Device name according to PROFINET „Name of station“
specification [} page 51]. For invalid inputs a red exclamation mark and
an error message will appear.
The name of station of the PROFINET IO-Device station can be edited in
the ‘Device properties’ of the ‘Topology Editor’ too.

Unique network
name of the device
according to the
PROFINET
specification 
(PNO document
2722).
1 - 240 characters
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Parameter Description Range of value /
value

Device The name of the physical device. Name for the device that is stored non-
volatile on the device.

Description The symbolic name of the device.
Vendor Name of the vendor of the device.

Table 17: Parameters of the Device table dialog pane
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6.5 IP address table
The IP address table dialog pane displays the name of the station and the
IP settings of the PROFINET IO-Device stations connected to the
PROFINET IO-Controller.

The IP settings (IP address, network mask and gateway address) of the
PROFINET IO-Device station can be set here. You can configure whether
the IP address is to be set manually and the network mask and gateway
address are to be taken from the PROFINET IO-Controller (default), or
whether the IP settings are to be set manually or to be taken from the
network.

The PROFINET IO-Controller device transmits the IP settings of the
PROFINET IO-Device station during startup via the PROFINET network to
the PROFINET IO-Device and configures the PROFINET IO-Device. In the
PROFINET IO Device DTM, the name of station and the IP settings of the
PROFINET IO-Device are only displayed.

Figure 51: Configuration > IP Address Table

Parameter Description Range of value /
value

Name of Station Network name of the PROFINET IO-Device station (not editable).
The name of station is set in the Device table in the PROFINET IO-
Controller DTM (refer to section Device table [} page 74]). Otherwise, it
must be set directly in the configuration tool of the PROFINET IO-Device.

1 - 240 characters

IP settings of the PROFINET IO-Device station (editable)
Mode Inherit (Standard): The IP address is set manually. The network mask

and the gateway address are taken from the controller network settings.
Assign manually: The IP address, network mask and the gateway
address can be set or changed manually.
Assume from network: The IP address, network mask and gateway
address are taken from the network settings (e.g. from the DHCP server).

Inherit(Standard),
Assign manually,
Assume from
network

IP address IP address of the PROFINET IO-Device station. valid IP address
Network mask Network mask of the PROFINET IO-Device station. valid network mask
Gateway address Gateway Address of the PROFINET IO-Device station. valid gateway

address
Table 18: IP address table pane parameters
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6.5.1 Set the IP settings of the PROFINET IO-Device station
The IP settings for the PROFINET IO-Device station can be inherited. In
this case, the IP address is set manually and the network mask or gateway
address are applied from the Controller Network Settings of the PROFINET
IO-Controller device, to which the PROFINET IO-Device is connected.
Alternatively, the IP settings can be set manually or can be applied from the
network settings. Proceed as follows:
Ø Select Configuration > IP address table in the navigation area.

Inherit
Ø Select the Inherit (Standard) mode.
Ø Set the IP address manually.
Ê The manually set IP address is applied to the PROFINET IO-Device.

Also, the network mask and gateway address from the Controller
Network Settings are applied.

Assign manually
Ø Alternatively select the Assign manually mode.
Ø Then set the IP address, network mask and gateway address manually.
Ê The manually set values are applied to the PROFINET IO-Device

station.

Note:
The fields Network mask and Gateway address are only editable
if Assign manually is selected.

Assume from network.
Ø Or select the Assume from network mode.
Ê The IP address, network mask and gateway address are applied from

the network settings (e.g. from the DHCP server) to the PROFINET IO-
Device station.
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6.6 Process data
For the PROFINET IO-Controller DTM the Process data pane serves as
an external process data interface, e. g. for data transfer to a PLC unit. The
process data pane lists the Slave devices connected to the Master, as well
as the configured modules or input or output signals of the devices. This
makes the fieldbus structure visible.

For the configured modules, submodules or measuring signals names
(tags) can be set (column "Tag").

In addition, it can be specified which signal data are to be made available
on the OPC server (column SCADA).

Figure 52: Process data

Column Symbol Description
Type  Device Device labeling* provided by the hardware followed by the device’s name of station in

pointy brackets

 module,
submodule

 I/O signal

Description of the modules, submodules or input or output signals configured on the
device (not editable)

Tag  Device Device name or the symbolic name of the device

 module,
submodule

 I/O signal

Symbolic name for the modules, submodules or input or output signals configured on the
device (editable)

 warning Duplicate Tag at the same level can cause errors by use of OPC!

SCADA Selection option which module, submodule or signal data should be made available on the OPC server.
„SCADA“ (= Supervisory Control and Data Acquisition), 
here used with the meaning „to provide for visualizing purposes“.

Table 19: Process data
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6.7 Isochronous modules
The Isochronous modules dialog pane displays IRT capable
(isochronous) devices or modules, or isochronously supported submodules,
which provide the isochronous mode. If not enabled or disabled by default
(fixed setting), the isochronous mode can be enabled or disabled in the
Isochronous column. It serves to determine for which isochronous devices
or modules or isochronously supported submodules the configured timing
parameters
· Options for calculation,
· Input time,
· Output time,
· Input interval steps,
· or Output interval steps will apply.

If the Automatic setting is selected (recommended), the automatically in
the background calculated timing parameters applies. In the expert mode
Manual, you can set the timing parameters yourself. These values applies
each for the entire selection.

Figure 53: Configuration > Isochronous modules (Example isochronous device and
configured modules and submodules)
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Parameter Description Range of value /
value

Image Icon for an isochronous device with isochronous mode

Icon for an isochronous module with isochronous mode

Icon (indented) for an isochronously supported sub module
with isochronous mode. In this case the GSDML file includes
an “IsochroneMode” node.

Type Name of an isochronous device or module or of an isochronously
supported submodule of a device with isochronous mode.

String

Tag Description of an isochronous device or module or of an isochronously
supported submodule of a device with isochronous mode.

String

Isochronous Indicates whether an isochronous device or module or an isochronously
supported submodule is in isochronous mode from application view.
Within a subnet (domain), the same clock time must be set for all IRT
devices or for all devices that contain isochronous modules or
isochronously supported submodules. If Isochronous is checked for an
IRT device within a subnet, the same clock time is automatically used for
all IRT devices in the corresponding subnet. The same applies to devices
with isochronous modules or isochronously supported submodules.

Isochronous mode is enabled by default if GSDML attribute
IsochroneModeRequired="true" is present.
Isochronous mode can be enabled or disabled by the user for
a single submodule, for all submodules in a module or for all
submodules of a device.

Timing parameters for Isochronous mode:
Options for calculation Manual or automatically calculation

Note! By default, use the Automatic setting! Use the Manual setting only
if you know exactly how to make the configuration.
Manual: Expert mode (refer also to [2])
Automatic: Automatically calculation in the background (recommended)

Manual, Automatic, 
Default: Automatic

Input time Bus-related input time
In isochronous applications, the time before the next network cycle begins
or when the isochronous PROFINET IO-Devices or input modules or the
isochronously supported sub-input modules should read in the input
values.

Editable only for
selection “Manual”

Output time Bus-related output time
In isochronous applications, the time before the next network cycle begins
or when the isochronous PROFINET IO-Devices or output modules or the
isochronously supported sub output modules should set the output values
towards the output.

Editable only for
selection “Manual”

Input interval steps The time pattern or isochronous interval steps specified in the GSDML file
for the input time or for receiving the input data.

0 … 
Default (typically): 
125 µs

Output interval steps The time pattern or isochronous interval steps specified in the GSDML file
for the output time or for sending the output data.

0 … 
Default (typically): 
125 µs

Table 20: Isochronous Modules pane parameters

For isochronous real-time communication within a subnet (domain), the
process data is sent in a fixed order, in equidistant (isochronous) time
intervals and isochronously to the other nodes. For IRT communication the
cyclic data transmission is deterministic and based on the clock of the
network master (sync master). The maximum allowed deviation from the
synchronization clock is 1 μs (jitter accuracy).
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Procedure for configuration:

1. Select the isochronous devices or modules or isochronous supported
submodules (if can be enabled*) for which the timing parameters
configured automatically or manually in this pane should apply by activating
the Isochronous option.
Ø Check isochronous.

*For isochronous supported submodules with the attribute
IsochroneModeRequired="true" in their GSDML file, Isochronous is
permanently checked.

2. Set isochronous mode parameters.

The isochronous mode parameters are configured on the device level.

Note:
By default, use the Automatic setting! Use the Manual (expert
mode) setting only if you know exactly how to make the
configuration.

Ø Under Options for calculation select Automatic (recommended).
ð The timing parameters are automatically configured in the background.

The calculated times apply to the entire selection, i. e. to all selected
devices, modules or submodules.

If Manual is selected, the input time or the output time for an isochronous
device or module or an isochronous supported submodule can be set
manually. The selected times apply to the entire selection. If a set value for
the input time or the output time at the device, an associated module or
submodule is changed again, a value previously set at another module or
submodule is overwritten for the device, all its modules and submodules.
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6.8 Address table
The Address table dialog pane shows a list of all addresses used in the
process data image. The displayed addresses refer to the used PROFINET
IO-Controller.

To configure the address data:
Ø Select Configuration > Address table in the navigation area.

Figure 54: Configuration > Address Table

Parameter Description Value range / value
Name of station Network name of the PROFINET IO device station.

The station name is only displayed here and can be edited in the
Device Table in the PROFINET IO Controller DTM (see section Device
table [} page 74]) or can be set directly in the PROFINET IO Device
configuration tool if necessary.

1 - 240 characters

Module Module name String
Submodule Submodule name String
Type Module or submodule data type Provider status, 

Process data,
Consumer status

Length Length of the module / submodule in bytes
Address Data offset address

Table 21: Address table pane parameters - inputs / outputs
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The Auto addressing  is used by default. For manual
addressing the check-box must be unchecked.

Via View mode  you can select the views
Submodules (default) or Devices.

Figure 55: Address table, view mode Devices (example)

Parameter Description Value range / value
Symbolic name Device description of the PROFINET IO-Device configured in the

PROFINET IO-Controller DTM.
Character string

Device Device name of the PROFINET IO-Device configured in the PROFINET
IO-Controller DTM.

Character string

Table 22: Address table dialog pane, additional parameters in the Devices view mode

Use Display mode  to select data display
mode decimal or hexadecimal.

The CSV export option allows to export input and output addresses as
CSV file (CSV = comma separated value). Therefore:
Ø Click to the CSV export button.
Ê A file saving dialog opens.
Ø Save the data as *.CSV file.

You can open the generated data by means of a spreadsheet application.

Inputs, outputs

If manual addressing is allowed, you assign the input or output addresses
of the modules manually:
Ø Click on an address of a module.
Ø Edit the field and type in a new address.
Ø Confirm your modifications by clicking on the OK button.
ð The manually changed address is now set.

DTM for Hilscher PROFINET IO-Controller devices (RT/IRT) | Configuration of contoller devices
DOC150704OI08EN | Revision 8 | English | 2023-07 | Released | Public

© Hilscher 2015 – 2023



Configuration 84/164

Address overlap

The configuration software reports an error if an address overlapping in the
process data image was detected. The configuration software reports the
first address overlapping, which was detected. The display includes the
Name of Station, the module, the submodule and especially the start
address and the length of the overlapping modules.

Figure 56: Configuration > Address table – address overlap

*The name of the PROFINET IO-Device is displayed.
Ø Correct the address for one of the two modules and enter an unused

address.
Ø Confirm your modifications by clicking on the OK respectively Apply

button.

Sort addresses
Ø To sort the address data, click on the respective column header.
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6.9 FSU/port settings
The FSU/port settings pane is used to set in the PROFINET IO-Controller
device whether a PROFINET IO-Device must use a fast start up (FSU)
connection to establish the cyclic data exchange. For this, all existing
Ethernet connections from the PROFINET IO-Controller to PROFINET IO-
Devices are displayed, including all existing ports at each Device.

For each PROFINET IO-Device and for each device port, a setting is
required via the MAU type whether the Device should automatically
negotiate the parameters for establishing the connection to the opposite
port on the Controller device or whether the parameters for this are fixed.

Important:
If you check FSU (fast start up) to establish a fast connection for a
port, use only the MAU type "100BASETXFD“. For the "AUTO"
setting the Auto negotiation and Auto crossover effects will prevent
establishing a fast Ethernet connection.

Ø Select Configuration > FSU/port settings.
Ø Check FSU for those PROFINET IO-Devices, which must use a fast

start up (FSU) connection to establish the cyclic data exchange.

Figure 57: FSU/port settings

*The name /**Name of Station of the Device is displayed.
Parameter Description Range of value /

value
Name The symbolic name of the PROFINET IO-Device station.
Name of Station Network name of the PROFINET IO-Device station.

The name of station is only displayed here and can be edited in the
Device table in the PROFINET IO-Controller DTM (see section Device
table [} page 74]) or can be set directly in the configuration tool for the
PROFINET IO-Device, if necessary.

1 - 240 characters
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Parameter Description Range of value /
value

MAU type The MAU-Type (MAU = Medium Attachment Unit) defines the physical
settings (PHY) on the PROFINET IO-Device. For each port at the device
the MAU type must be set separately.
„AUTO“: For this setting, the connection between adjacent Devices is
negotiated automatically. It may take 2-3 seconds for the physical
connection is established.
„100BASETXFD“ [4]: For this setting, the connection between adjacent
Devices is fixed with 100 MBit /Fullduplex.
Important for hardware wiring!
(1) Make wiring only between ports with the same port setting (MAU-Type
configuration). Otherwise, no connection can be established between the
Devices or only in half duplex mode.
(2) Connect only ports with each other, which have different cross-over
settings. Otherwise, a connection between the devices can not be
established. Refer to the manual of the end device manufacturer to get
information which crossover settings are set on the used device.
Respectively use crossover cables.

AUTO,
100BASETXFD

FSU In the PROFINET IO-Controller device must be configured for each
PROFINET IO-Device, whether the Device must use a fast start up (FSU)
connection to establish the cyclic data exchange.

checked, 
unchecked

Table 23: FSU/port settings
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6.10 Stations timing
Ø Select Configuration > Stations timing in the navigation area.

In the Stations timing dialog pane for each selected PROFINET IO-Device
station you can make the following stations timing settings:

Not IRT capable devices:
· Station global settings ‘Updating time’ and ‘Watchdog time’.

Figure 58: Configuration > Stations timing, example ‘Unsynchronized (RT)’ by default

IRT capable devices or IRT capable devices with isochronous mode:
· Unsynchronized (RT) or synchronized (isochronous) real-time

communication (IRT),
· station global settings ‘Updating time’ and ‘Watchdog time’,
· or sync domain settings ‚Name‘ and ‚Basic send-clock‘.

‚Basic send-clock‘ is only valid for IRT. In a sync domain for all IRT
participants globally an identical value for ‚Basic send-clock‘ is valid. This is
the basic clock of all IRT participants.
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Figure 59: Configuration > Stations timing, example ‘Synchronized (IRT)’ (editable)

Figure 60: Configuration > Stations timing, example ‚Synchronized (IRT)‘, isochronous mode
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6.10.1 Parameters in the ‘Stations Timing’ pane
The following table shows the parameters description of the Station
Timing pane:

Parameter Description Range of value /
value

Station global Settings
Name of station Network name of the PROFINET IO-Device station. Under Name of

station all devices are displayed, which are connected to the PROFINET
IO-Controller.
The corresponding name of station is set in the Device Table in the
PROFINET IO Controller DTM (refer to section Device Table on page 80 )
or otherwise it must be set directly in the configuration tool of the
PROFINET IO-Device.

1 - 240 characters

Isochronous
(not editable)

Indicates whether the isochronous mode is used or not.
Note: The selection, whether the isochronous mode is to be used or not,
for devices module or submodules, is made in the Isochronous Modules
pane, in the Isochronous column (see section Isochronous
modules [} page 79]).
Meaning if checked
· Device is IRT-capable (isochronous), or contains isochronous modules

or isochronously supported submodules, provides isochronous mode
and uses isochronous mode.

Meaning if not checked:
· Device is RT capable (not IRT capable), or does not contain

isochronous modules or isochronously supported submodules.
· OR: Device is IRT-capable (isochronous), or contains isochronous

modules or isochronously supported submodules, does not provide
isochronous mode.

· OR: Device is IRT-capable (isochronous), or contains isochronous
modules or isochronously supported submodules, provides isochronous
mode, does not use isochronous mode.

checked, unchecked

RT mode · Unsynchronized (RT): The setting involves that RT (= Real-Time) is
used. The data exchange from the PROFINET IO-Controller with this
PROFINET IO-Device is not synchronized. 
‘Unsynchronized (RT)’ as a fixed setting means that this device does
not support a synchronized (isochronous) real-time communication.

· Synchronized (IRT): The setting involves that IRT (=Isochronous Real-
Time) is used. The data exchange from the PROFINET IO-Controller
with this PROFINET IO-Device is synchronized. 
‘Synchronized (IRT)’ as a fixed setting means that this device supports
a synchronized (isochronous) real-time communication and provides
the isochronous mode. ‘Synchronized (IRT)’ as a selectable setting
involves that the values ‘Updating time’, ‘Watchdog time’ and ‘Basic
send-clock’ are adjusted to each other.

Note: The isochronous mode is to be enabled in the Isochronous
Modules pane, in the Isochronous column (see section Isochronous
modules [} page 79]).
For synchronized real-time communication (IRT communication), the
process data is send in a fixed order, in equidistant (isochronous) time
intervals and isochronously to the other participants on the bus.
If you select IRT mode, the PROFINET IO-Controller is automatically
assigned as the sync Master, as well, the assignment of the sync domain
name is done.
Note that the settings made here are taken over for ,Synchronization role’
in the Topology Editor and vice versa. For more information, refer to the
operation instruction manual Topology Editor.

Fixed or selectable: 
Unsynchronized
(RT), 
Synchronized (IRT)
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Parameter Description Range of value /
value

Updating Time [ms] Eligible (total) cycle time of the device to exchange data.
RT mode = RT: For each unsynchronized device, a value for ,Updating
time' can be chosen. There is no dependence on other variables.
RT mode= IRT: For each synchronized device only those values
for ,Updating time' can be selected which are permissible, in dependence
to the value selected for ‚Basic send-clock‘.
Important! Values for ‘Updating time’, which after a change of ‚Basic
send-clock‘ are marked with a red exclamation mark, result in an invalid
configuration and must be adjusted manually or via Adjust, before the
configuration is completed.

RT mode RT: 
All values that are
defined in the
GSDML file are
selectable.
RT mode IRT: 
Only permissible
values can be
selected.

Watchdog Time [ms] Time, after which a device reports the absence of cyclic telegrams and
passes over to the error state. The value must be an integer multiple of
the cycle time (updating time), (with restrictions from the GSDML file).

Integer multiple of
‘Updating time’

Adjust Serves in ‘IRT’ mode as auto-correction of invalid values for ‘Updating
time’. For any invalid values for ‘Updating time’ the closest valid values
are set automatically.
Alternatively, the values can be corrected manually.

Sync domain settings
Sync domain name DNS compatible name in accordance with the "Name of Station" naming

convention. For further information refer to section Device name
according to PROFINET „Name of station“ specification [} page 51]. For
invalid inputs a red exclamation mark and an error message will appear.
The sync domain includes all devices that are controlled by one sync
Master. In the ‘Topology Editor’ currently only one sync domain is
supported.
The packet synchronization for the IRT communication (synchronized
real-time communication) is controlled by a sync Master. For each sync
domain exactly one sync Master is determined. The Hilscher PROFINET
IO-Controller device takes over the role as sync Master. The sync Master
sets the synchronization clock for data exchange with the sync Slaves.

All devices in
RT mode RT:
disabled (grayed
out)
At least 
one device in the 
RT mode IRT: 
Name acc. to
PROFINET
specification 
(PNO document
2722)
1 - 240 characters

Basic send-clock Basic clock of all IRT participants of the sync domain. Thus, no
PROFINET IO-Device is capable to exchange cyclical data faster than
any other participant.
RT mode = RT: For unsynchronized devices ‚Basic send-clock‘ is
disabled (grayed out).
RT mode= IRT: For synchronized devices the value selected for ‚Basic
send-clock‘ decides about the values selectable for ,Updating time'.
Note: By changing the ‚Basic send-clock‘ factor invalid values for the
cycle time (‘Updating time) of PROFINET IO-Devices can be generated.

All devices in
RT mode RT: 
disabled (grayed
out)
At least one 
device in the 
RT mode IRT: 
All values that are
defined in the
GSDML file are
selectable.

Table 24: Parameters in the ‘Stations Timing’ pane
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6.10.2 Configuration steps Stations Timing

6.10.2.1 Example ‚Unsynchronized (RT)‘

Figure 61: Configuration > Stations Timing, Example ‘Unsynchronized (RT)’ by default

Ø Adjust the values for Updating time manually or via Adjust.
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Figure 62: Configuration > Stations Timing > ‚Updating time‘ to be adjusted, Example
‚Unsynchronized (RT)‘

Figure 63: Configuration > Stations-Timing > ‚Updating time‘ adjusted, Example
‚Unsynchronized (RT)‘

Ø Adjust the values for Watchdog time manually.
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Figure 64: Configuration > Stations-Timing > ‚Watchdog‘ to be adjusted, Example
‚Unsynchronized (RT)‘

Ø Apply all settings or complete the configuration via OK.
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6.10.2.2 Example ‚Synchronized (IRT)‘
Ø For each PROFINET IO-Device station select the station RT mode.

Figure 65: Configuration > Stations Timing, Example ‘Synchronized (IRT)’

Figure 66: Configuration > Stations-Timing > RT mode to be selected, Example
‚Synchronized (IRT)‘
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Figure 67: Configuration > Stations-Timing > RT mode selected, Example
‚Synchronized (IRT)‘

Ø For each PROFINET IO-Device station select the Basic send-clock
factor.

Figure 68: Configuration > Stations-Timing > Send-Clock, Example ‚Synchronized (IRT)‘
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Important:
By changing the ‚Basic send-clock‘ factor invalid values for the cycle
time (‘Updating time) of PROFINET IO-Devices can be generated.
Values, which are marked with a red exclamation mark, result in an
invalid configuration and must be adjusted before the configuration
is complete.

Figure 69: Configuration > Stations-Timing > ‚Updating time‘ to be adjusted, Example
‚Synchronized (IRT)‘

Ø Adjust the values for Updating time manually or via Adjust.

DTM for Hilscher PROFINET IO-Controller devices (RT/IRT) | Configuration of contoller devices
DOC150704OI08EN | Revision 8 | English | 2023-07 | Released | Public

© Hilscher 2015 – 2023



Configuration 97/164

Figure 70: Configuration > Stations-Timing > ‚Updating time‘ adjusted, ‚Synchronized
(IRT)‘

Ø Adjust the values for Watchdog time manually.

Figure 71: Configuration > Stations-Timing > ‚Watchdog‘ to be adjusted, Example
‚Synchronized (IRT)‘
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Figure 72: Configuration > Stations-Timing > ‚Watchdog‘ to be adjusted, Example
‚Synchronized (IRT)‘

Ø Apply all settings or complete the configuration via OK.
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6.10.2.3 Example ‚Synchronized (IRT)‘, Isochronous mode

Figure 73: Configuration > Stations Timing, Example ‚Synchronized (IRT)‘, Isochronous
mode

Ø For each PROFINET IO-Device station select the Basic send-clock
factor.
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Figure 74: Configuration > Stations-Timing > Send-Clock, Example ‚Synchronized
(IRT)‘, Isochronous mode

Important:
By changing the ‚Basic send-clock‘ factor invalid values for the cycle
time (‘Updating time) of PROFINET IO-Devices can be generated.
Values, which are marked with a red exclamation mark, result in an
invalid configuration and must be adjusted before the configuration
is complete.
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Figure 75: Configuration > Stations-Timing > ‚Updating time‘ to be adjusted, Example
‚Synchronized (IRT)‘, Isochronous mode

Ø Adjust the values for Updating timemanually or via Adjust.

Figure 76: Configuration > Stations-Timing > ‚Updating time‘ adjusted, Example
‚Synchronized (IRT)‘, Isochronous mode
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Ø Adjust the values for Watchdog time manually.

Figure 77: Configuration > Stations-Timing > ‚Watchdog‘ to be adjusted, Example
‚Synchronized (IRT)‘, Isochronous mode
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Figure 78: Configuration > Stations-Timing > ‚Watchdog‘ adjusted, Example
‚Synchronized (IRT)‘, Isochronous mode

Ø Apply all settings or complete the configuration via OK.
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6.11 Controller settings
At the Controller settings pane device related settings can be made.
These settings only become active after the configuration was downloaded
to the device. Information about the download you find in section Download
configuration [} page 109].
Ø Open Configuration > Controller settings.

Figure 79: Configuration > Controller settings

Note:
The setting options at the dialog pane Controller settings for client
specific variants of the configuration software can differ from the
setting options displayed here.
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6.11.1 Start of bus communication

Figure 80:  PROFINET IO-Controller settings > Start of bus communication

If Automatically by device is selected, the PROFINET IO-Controller
device will start with the data exchange on the bus after the initialization
has been finished.

When Controlled by application is selected, the application program must
activate the data exchange on the bus.

6.11.2 Application monitoring

Figure 81: Controller settings > Application monitoring

The Watchdog time determines the time within which the device watchdog
must be re-triggered from the application program while the application
program monitoring is activated. When the watchdog time value is equal to
0 the watchdog is deactivated and the application program monitoring is
deactivated too.

The permissible range of values of the watchdog time is 20 to 65535. By
default the watchdog time value equals to 1000 ms.
Watchdog time Range of value / value
Permissible range of values 20 … 65535 ms
Default 1000 ms
The software watchdog is deactivated. 0 ms

Table 25: Range of value / Value for the watchdog time
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6.11.3 Port settings
For each port must be configured, whether the PROFINET IO-Controller
device should establish the connection automatically (setting:„AUTO“) or
whether fixed parameters are to be used (setting:„100BASETXFD“).

Figure 82: Controller settings > Port settings

Parameter Description Range of value /
value

Port settings Port 1,
Port 2

Port settings is to be set for each port (port 1, port 2) of the PROFINET
IO-Controller separately.
„AUTO“: For this setting, the connection between adjacent Devices is
negotiated automatically. It may take 2-3 seconds for the physical
connection is established.
„100BASETXFD“ [4]: For this setting, the connection between adjacent
Devices is fixed with 100 MBit /fullduplex.

AUTO,
100BASETXFD

Table 26: Parameters port settings

Important:
(1) Make wiring only between ports with the same port setting.
Otherwise, no connection can be established between the Devices
or only in half duplex mode.
(2) Connect only ports with each other, which have different cross-
over settings. Otherwise, a connection between the devices cannot
be established. Refer to the manual of the end device manufacturer
to get information which crossover settings are set on the used
device. Respectively use crossover cables.

Note:
The setting options under Port Settings for client specific variants of
the configuration software can differ from the setting options
displayed here.
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6.12 Connecting/disconnecting device

Note:
Several PROFINET IO-Controller DTM functions, e. g. diagnosis or
the configuration download in SYCON.net, require an online
connection from the PROFINET IO-Controller DTM to the
PROFINET IO-Controller device.

Connecting device

To establish an online connection from the PROFINET IO-Controller device
to the PROFINET IO-Controller DTM, take the following steps:

Under Settings in the Driver pane:
Ø Verify that the default driver is checked and respectively check another

or multiple drivers.
Ø Configure the driver if necessary.

Under Settings in the Device assignment pane:
Ø Scan for the devices (with or without firmware).
Ø Select the device (with or without firmware) and apply the selection.

Before you download the firmware, adhere to the necessary safety
precautions to prevent personnel injury and property damage that may
occur in consequence of a communication stop. For further details, please
refer to the Safety chapter.

Under Settings in the Firmware download pane, if not yet a firmware was
loaded to the device:
Ø Selecting and downloading the firmware.

Under Settings in the Device assignment pane, if not yet a firmware was
loaded to the device:
Ø Scan for the device (with firmware) once more.
Ø Select the device (with firmware) once more.

For more information, see sections on driver settings and device
assignment.
Ø In the DTM interface dialog, select the OK button, to apply the selection

and to close the DTM interface dialog.
Ø Right-click on the PROFINET IO-Controller icon.
Ø Select Connect from the context menu.
Ø The PROFINET IO-Controller device now is connected to the

PROFINET IO-Controller DTM via an online connection. In the network
view, the device description at the device icon is displayed with a green
colored background.
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Disconnecting device

To disconnect an online connection from the PROFINET IO-Controller
device to the PROFINET IO-Controller DTM, take the following steps:
Ø Right-click on the PROFINET IO-Controller icon.
Ø Select Disconnect from the context menu.
ð In the network view, the device description is not any more displayed

with a green colored background. Now the online connection from
PROFINET IO-Controller device to the PROFINET IO-Controller DTM.

DTM for Hilscher PROFINET IO-Controller devices (RT/IRT) | Configuration of contoller devices
DOC150704OI08EN | Revision 8 | English | 2023-07 | Released | Public

© Hilscher 2015 – 2023



Configuration 109/164

6.13 Download configuration
The device configuration is created "offline" in the DTM (application
program). A download to the device is required, to transfer the configuration
with the parameter data to the device.

Note:
To download configuration parameter data to the PROFINET IO-
Controller device an online connection from the PROFINET IO-
Controller DTM to the PROFINET IO-Controller device is required.
Further information can be found in Connecting/disconnecting
device [} page 107].

 Communication stop caused by configuration download,
faulty system operation possible or loss of device parameters

Before you initiate a configuration download process, while the bus is still in
operation status:
Ø Stop the application program.
Ø Make sure that all network devices are in a fail-safe condition.

 Mismatching system configuration, faulty system or
device operation possible
Ø In the device, use only a configuration suitable for the system.

 Loss of device parameters caused by power disconnect
during configuration download
Ø During configuration download process, do not interrupt the power

supply to the PC or to the device, and do not perform a reset to the
device!

Download steps

In order to transfer the configuration with the corresponding data of the
configuration parameters to the PROFINET IO-Controller device, download
the data via Device > Download or context menu Download.
Ø Select Download in the context menu of the device.
Ê If the download is started as long as the slave devices are connected to

the master device, the following message is displayed: "If you attempt to
download during bus operation, communication between master and
slaves is stopped. Do you really want to download?"

Figure 83: netDevice Message: Download
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Important:
If the communication between the controller device and the Devices
is stopped, the data exchange between the controller device and
the Devices is stopped.

Ø Click Yes if you intend to download the configuration.
Ê Then the current configuration in the application program is down

loaded to the device.
Ø Otherwise click to No.
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6.14 Network scan and upload
With the function Network scan... of the PROFINET IO-Controller DTM
you can find out automatically, which PROFINET IO-Device are attached to
the PROFINET IO-Controller device and how these devices are configured.
During the network scan the controller device requests the ident codes of
the Devices found at the bus. For each connected PROFINET IO-Device its
ident code is read out.

In the Scan response dialog of the controller DTM the assigned device
description files or DTM devices appear. Each device description file and
each DTM device is assigned exactly one ident code. Different versions
(also language versions) of the same device description file are defined by
the same ident code. For each identified device, you can select the
assigned DTM device according to the firmware loaded in that Device. Via
Create devices for each Device the selected DTM device is created.

The IP settings of the Device can be set manually in the controller if
necessary.

Note:
The IP settings of the Device must be downloaded to the controller
device, before the module configuration upload is started.

The upload of the configuration is proceeded subsequent to a network
scan procedure. The upload function of the PROFINET IO-Device DTM
allows to upload module configuration data from all PROFINET IO-Devices
via the PROFINET IO-Controller device and the PROFINET IO-Controller
DTM to the PROFINET IO-Device DTMs.

6.14.1 Requirements
The PROFINET IO-Controller device must be configured.

Important:
The configuration of the controller device must be downloaded to
the controller device. For further details refer to section
Configuration steps [} page 15].
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6.14.2 Overview on steps
1. Start the Network scan (in the controller DTM).
2. Make the settings in the Scan response dialog.
3. Click Create devices.
4. Via Download, download the IP settings of the Device to the controller

device.
5. Via Upload (in the device DTM), upload the device configuration of

each Device to the controller DTM, and create the module configuration.
6. Via Download (in the controller DTM), download the current

configuration of the Devices to the controller device.

6.14.3 Starting network scan
Ø In netDevice: Right-click on the device symbol of controller DTM.
Ø Select Network scan... from the context menu.

Figure 84: Starting ‘Network scan’ (example)

Ø Wait for a moment.

Note:
It may take a few seconds to display the Scan response dialog of
the PROFINET IO-Controller DTM.
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Ø Via Network scan... an online connection from the PROFINET IO-
Controller DTM to the PROFINET IO-Controller device is established.
SYCON.net scans, which PROFINET IO-Devices are connected to the
network or the PROFINET IO-Controller device.

ð The Scan response dialog of the controller DTM appears.

Figure 85: Scan response dialog of the controller DTM (example)
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6.14.4 Scan response dialog settings
Ø Make the settings in the Scan response dialog of the PROFINET IO-

Controller DTM.
Ê In the DTM device column the DTM devices assigned to the found ident

codes appear.

Figure 86: Scan response dialog of the PROFINET IO-Controller DTM (example)

Ø In the DTM device column, select for every identified device the DTM
device corresponding to the firmware loaded in this PROFINET IO-
Device.

· If in the DTM device column no DTM device or a DTM device not
desired is displayed, add the required DTM devices to the device
catalog.

· Or adapt the creation mode under Creation mode.
Ø In the Action column select, whether the found DTM device shall be:
· added or skipped 

(if a device is not yet present in the project),
· or replaced or skipped 

(if a device is already present in the project).
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6.14.5 Scan response dialog
In the following table, you find a description about the Scan response
dialog of the PROFINET IO-Controller Master DTM.

Column Description
Title bar With the text: "Symbolic Name [Device description] (#Network ID) channel/[Name of the network]". It

is the symbolic name of the PROFINET IO PROFINET IO-Controller device.
Instruction In the Network Scan window, the instruction text is displayed: The following hardware-devices

have been found during network scan. Please check automatic selection of corresponding
devices found in device catalog in column ‘DTM devices’ before creating devices.

Station address PROFINET IO station address, which displays the logical sequence of the devices within a
PROFINET IO network.

Colors Meaning of colors in the Scan response dialog of the PROFINET IO-Controller DTM:
If a field marked in red appears in column Station address, the respective DTM device is
already present on the network.
If a field appears marked in yellow, a selection can be made by a combo box.

Device type ID Identification (ID): Ident code read out from each device (Unique Identifier)
Sub device type Sub-device type of the device type, if applicable (not used in PROFIBUS).
DTM to use Display of the DTM devices, which are assigned to the ident codes found during scanning: 

If  is displayed without color marking, there is no selection
possibility. 
If  is displayed marked in yellow, the following selection can be
made: 

(In the figure shown example DTMs are displayed.) A selection will only be displayed if under
Creation Mode > Choose for each device was selected and if another DTM has been found for the
respective device.
A selection will only be displayed if under Creation mode > Choose for each device was selected
and if another DTM has been found for the respective device.

Device class Device class of the PROFINET IO-Device.
DTM device Found DTM device (the device name as taken from the DTM). 

Only the device description files or DTM devices can be displayed within the column DTM devices:
· Which are available in the device catalog for the scanned ident code,
· Respectively, which belong to the selection made under Creation mode
· and which belong to the selection made under Creation mode > Choose for each device under

DTM to create.
For each device type ID in the
column DTM device the following
is displayed:
· no device,
· one single device

· or multiple devices 
(within a combobox).

This means, within the device catalog of netDevice for the found
ident code and the selected Creation mode these alternatives
are available:
· no DTM,
· a device description file respectively a DTM device of a

manufacturer,
· or one or more device description files respectively a DTM

devices of a manufacturer.
Quality Associated quality information 

Display: [1] DTM found, [3] Generic found
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Column Description
Action The action to be performed with the corresponding device during the process of device creation.

· If no device is present within the current project, the selection Add/Skip will appear.
· If there is already a device present within the current project, the selection Replace/Skip will

appear.
Add adds during the device creation process a new instance for the selected DTM to the newly
found device address.
Skip skips the device creation process for the respective device address.
Replace erases the instance of the DTM currently located at this address during the device creation
process, and replaces it with the instance of the chosen DTM.

Table below
The lower table in the Scan response dialog of the PROFINET IO-Controller DTM shows a
comparison of possible differences in device information taken from:
· The hardware device (displayed in central column of 3)
· and the DTM (displayed in right column of 3)
The left column contains which information is compared between the information sources "Hardware
Device" and "DTM".
Note! If a field contains the text ‘n/a’, the corresponding information is not applicable in the current
context (fieldbus).

Creation mode Under Creation mode one of the following options can be selected:
· Use Hilscher generic DTM if available
· Use vendors DTMs if available
· Choose for each device
Scan response dialog of the PROFINET IO-Controller DTM > "Creation mode"

Create devices About Create devices...
· for each PROFINET IO-Device the previously selected DTM device is created.
· the PROFINET IO-Device configuration is uploaded to the created PROFINET IO-Device DTM and

thereby the module configuration is generated.
In case a conflict occurs between a device description file and a device, the Upload dialog appears
where conflicts are displayed in red.

Cancel Click Cancel to leave the dialog without creating a device.
Table 27: Description on the Scan response dialog of the PROFINET IO-Controller DTM
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6.14.6 Creating devices
Ø In the Scan response dialog of the PROFINET IO-Controller DTM click

Create devices.
Ø The Device Network scan - Creating devices dialog opens. The dialog

shows the progress of the device creation process

Note:
Depending on the device manufacturer, a dialog that differs from
this can also be displayed.

Ø The question appears: "The current module and submodule
configuration of the connected device will be read out now. Do you want
to apply the read-out module and submodule configuration?" "Yes"/"No"

Figure 87: Query to create the module configuration (example)

Ø Click No.
ð The selected DTM device is created for each device.
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6.14.7 Downloading IP settings

Safety precautions

Adhere to the necessary safety precautions to prevent personnel injury and
property damage. For further details, please refer to the Safety chapter.

How to proceed

Use the Download function of the PROFINET IO-Controller DTM to
download the IP settings of the PROFINET IO-Device to the PROFINET
IO-Controller device:

Figure 88: 'Download' - download the modified configuration to the PROFINET IO-Controller
device (example)

Ø In netDevice: Right-click on the device symbol of the PROFINET IO-
Controller DTM.

Ø Select Download from the context menu.
Ê The netDevice - Download dialog appears: “If you attempt to download

during bus operation, communication between master and slaves is
stopped. Do you really want to download?”

Ø Click Yes.
Ê The netDevice dialog appears, with the progress bar Download active,

device performances initialization…
ð The netDevice window displays the message (example): “Download

succeeded to device CIFX_RE_PNM[CIFX RE/PNM]<>(# 1).”
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6.14.8 Upload and module configuration
Use the Upload function to upload the device configuration of each Device
(physical device) to the Device DTM.
Ø In netDevice: Right-click on the device symbol of the PROFINET IO-

Device DTM.

Figure 89: 'Upload' the configuration of the device (example)

Ø Select Upload from the context menu.
Ê The dialog Device Symbolic Name of the Controller Device [Device

Description] <Device Address> Starting Upload … appears. The dialog
shows the progress of the upload process.

Note:
Depending on the device manufacturer, a dialog that differs from
this can also be displayed.

Ê The question appears: "The current module and submodule
configuration of the connected device will be read out now. Do you want
to apply the read-out module and submodule configuration?" "Yes"/"No"
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Figure 90: Query to create the module configuration (example)

Ø Click Yes.
Ê For the Device, its current configuration is uploaded to the Device DTM

via the Controller device and the Controller DTM.
Ê The successful progress of the upload procedure is reported in the

output window.

Note:
If you start the Upload function and have not yet assigned an IP
address for the Device during a new installation, you receive the
error message: Upload failed from device. For more information,
see Upload failed from device [} page 124].
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Figure 91: Upload successful (example)

After the module configuration of the PROFINET IO-Device has been
created, you can display the uploaded modules by double-clicking the
Device symbol.
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Figure 92: Uploaded modules (example)

DTM for Hilscher PROFINET IO-Controller devices (RT/IRT) | Configuration of contoller devices
DOC150704OI08EN | Revision 8 | English | 2023-07 | Released | Public

© Hilscher 2015 – 2023



Configuration 123/164

6.14.9 Downloading configuration

Safety precautions

Adhere to the necessary safety precautions to prevent personnel injury and
property damage. For further details, please refer to the Safety chapter.

How to proceed

Use the Download function of the PROFINET IO-Controller DTM to
download the device configuration of the PROFINET IO-Devices to the
PROFINET IO-Controller device:
Ø In netDevice: Right-click on the device symbol of the PROFINET IO-

Controller DTM.
Ø Select Download from the context menu.
Ê The netDevice - Download dialog appears: “If you attempt to download

during bus operation, communication between master and slaves is
stopped. Do you really want to download?”

Ø Click Yes.
Ê The netDevice dialog appears, with the progress bar Download active,

device performances initialization…
ð The netDevice window displays the message (example): “Download

succeeded to device CIFX_RE_PNM[CIFX RE/PNM]<>(# 1).”
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6.14.10 Upload failed from device
If you start the Upload function and you have not yet assigned the IP
address to a reinstalled Device, you receive the following error message:
Upload failed from device Symbolic Name of the Device [Device
Description] <Device Address>! You might find additional information in
the output window.

Figure 93: Upload failed from device (example)

Ø In this case, assign the IP settings.
Ø Then load the changed configuration into the Controller device.
Ø Then start the Upload function again.
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7 Diagnosis

7.1 Overview diagnosis
The dialog Diagnosis serves to diagnose the device behavior and
communication errors. For diagnosis, the device must be in online state.

Figure 94: Navigation area - Diagnosis

Online connection to the device

Note:
Accessing the Diagnosis panes of the PROFINET IO-Controller
DTM requires an online connection from the PROFINET IO-
Controller DTM to the PROFINET IO-Controller device. For further
information refer to section Connecting/disconnecting
device [} page 107].

How to proceed
Ø In the diagnosis dialog, check whether the communication is OK:

Diagnosis > General diagnosis > Device status "Communication"
must be green!

Ø "Communication" is green: Open the IO monitor and test the input or
output data.

Ø "Communication" is not green: Use Diagnosis and Extended
diagnosis for troubleshooting.

Extended diagnosis

The Extended diagnosis helps to find communication and configuration
errors, when default diagnosis fails.

For further information, refer to chapter Extended diagnosis [} page 131].
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7.2 General diagnosis
Information regarding the Device State and other general diagnosis
parameters are displayed in the General Diagnosis dialog.

Figure 95: General diagnosis

LED Description Color State
Device state

Communication Shows whether the PROFINET IO device executes
the network communication.

 (green) In COMMUNICATION state

 (gray) Not in COMMUNICATION
state

Run Shows whether the PROFINET IO device has been
configured correctly.

 (green) Configuration OK

 (gray) Configuration not OK

Ready Shows whether the PROFINET IO device has been
started correctly. The PROFINET IO device waits
for a configuration.

 yellow Device READY

 (gray) Device not READY

Error Shows whether the PROFINET IO device records a
device status error. For further information about
the error characteristics and the number of counted
errors refer to the extended diagnosis.

 (red) ERROR

 (gray) No ERROR

Network state
Operate Shows whether the PROFINET IO device is in data

exchange. In a cyclic data exchange the input data
or the output data of the PROFINET IO-Controller
is transmitted to the PROFINET IO-Device.

 (green) In OPERATION state

 (gray) Not in OPERATION state

Idle Shows whether the PROFINET IO device is in data
exchange. The connection establishment between
PROFINET IO-Controller and PROFINET IO-
Device is in progress.

 (yellow) In IDLE state

 (gray) Not in IDLE state

Stop Shows whether the PROFINET IO device is in Stop
state: There is no cyclic data exchange at the
PROFINET IO network. The PROFINET IO device
was stopped by the application program or it
changed to the Stop state because of a bus error.

 (red) In STOP state

 (gray) Not in STOP state
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LED Description Color State
Offline The PROFINET IO-Controller is offline as long as it

does not have a valid configuration.
The PROFINET IO-Device does not have a valid
configuration.

 (yellow) In OFFLINE state

 (gray) Not in OFFLINE state

Configuration state
Configuration
locked

Shows whether the PROFINET IO device
configuration is locked, to avoid the configuration
data is typed over.

 (yellow) Configuration not LOCKED

 (gray) Configuration not LOCKED

New
Configuration
pending

Shows whether a new PROFINET IO device
configuration is available.

yellow New configuration pending

 (gray) No new Configuration
pending

Reset required Shows whether a firmware reset is required as a
new PROFINET IO device configuration has been
loaded into the device.

yellow RESET required

 (gray) No RESET required

Bus ON Shows whether the bus communication was started
or stopped. I. e., whether the device is active on the
bus or no bus communication to the device is
possible and no response telegrams are sent.

 (green) Bus ON

 (gray) Bus OFF

Table 28: Indication general diagnosis

Parameter Description
Communication
error

Shows the name of the communication error. If the cause of error is resolved, the value will be set
to zero again.

Watchdog time Shows the watchdog time in ms.
Error count This field holds the total number of errors detected since power-up, respectively after reset. The

protocol stack counts all sorts of errors in this field no matter whether they were network related or
caused internally.

Table 29: Indication general diagnosis
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7.3 Master diagnosis
Information regarding the slave state, slave errors and slaves configured,
active or in diagnostic is displayed in the Master Diagnosis dialog.

Figure 96: Master diagnosis

Parameter Description Range of value /
value

Slave state Shows whether slave state is ok or not.
The slave state field for master diagnosis shows whether the master is in cyclic
data exchange to all configured slaves. In case there is at least one slave
missing or if the slave has a diagnostic request pending, the status will be set to
FAILED. For protocols that support non-cyclic communication only, the slave
state is set to OK as soon as a valid configuration is found.

UNDEFINED, OK,
FAILED

Slave error log
indicator

Shows whether the slave error log indicator is available.
The error log indicator field holds the number of entries in the internal error log. If
all entries are read from the log, the field will be set to zero.

EMPTY,
AVAILABLE

Configured
slaves

Shows the number of configured slaves.
Number of configured slaves in the network according to the slave list derived
from the configuration database created by the configuration software. The list
includes the slaves to which the master has to open a connection.

Active slaves Shows number of active slaves.
Number of slaves in data exchange mode. The list includes the slaves to which
the Master has successfully opened a connection

Slaves with
diagnostic

Shows number of slaves with diagnostic.
Number of slaves with diagnosis or error slaves.

Table 30: Parameters Master diagnosis
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7.4 Station diagnosis

Figure 97: Station diagnosis

The Station diagnosis shows the status for all PROFINET IO-Device,
which are configured in the PROFINET IO-Controller. The PROFINET IO-
Controller DTM updates this display cyclically.

Column Description Value range / value
Status The status of the device addressed under the displayed IP

address.
Running, Diagnosis,
Not found, Error

Station name Network name of the PROFINET IO device station. 1 - 240 characters
IP address IP address of the PROFINET IO-Device station under which the

device is addressed.
If the device was not found or if there is a diagnostic or error
message for the device, no IP address appears.

Valid IP address

Table 31: Columns of the Station diagnosis table

The legend below describes the possible values for the state of a device,
which is assigned to a station address.

Color Name Description
green Running The device associated with this station address is running.
yellow Diagnosis Diagnosis is available for the device associated with this station address.
blue Not found The device associated with this station address was parameterized, but not found.
red Error An error message is available for the device associated with this station address.

For the status ,error' additionally a textual error messages can appear.
Table 32: Possible values for the status

DTM for Hilscher PROFINET IO-Controller devices (RT/IRT) | Configuration of contoller devices
DOC150704OI08EN | Revision 8 | English | 2023-07 | Released | Public

© Hilscher 2015 – 2023



Diagnosis 130/164

7.5 Firmware diagnosis
In the dialog Firmware Diagnosis, the current task information of the
firmware is displayed.

Under Firmware or Version the name of the firmware and version
(including the date) are indicated.

Figure 98: Firmware Diagnosis

Task information:

The table Task Information is listing the task information of the single
firmware tasks.
Task Description
Task Name of task
Name of task Name of the task
Version Version number of the task
Prio Priority of the task
Description Description of the task
Status Current status of the task

Table 33: Description table task information
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8 Extended diagnosis

8.1 Overview extended diagnosis
The "Extended Diagnosis" of the PROFINET IO-Controller DTM helps to
find communication and configuration errors, when default diagnosis fails.
Therefore, it contains a list of diagnosis structures as online counter, states
and parameters.

The table below gives an overview for the extended diagnosis dialog panes
descriptions of the PROFINET IO-Controller DTM:

Folder name / Section Subsection
different folders Task information [} page 132]
RX-SYSTEM IniBatch status [} page 133]
PNM_AP Configuration state [} page 134]

Network state [} page 135]
Communication state [} page 136]
Most recent logbook entries [} page 137]
PROFINET interface state [} page 138]
PROFINET switch diagnosis [} page 139]
System state [} page 139]

Table 34: Descriptions of the dialog panes extended diagnosis

Note:
Accessing the Extended Diagnosis dialog panes of the PROFINET
IO-Controller DTM requires an online connection from the
PROFINET IO-Controller DTM to the PROFINET IO-Controller
device. For further information refer to section Connecting/
disconnecting device [} page 107].
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8.2 Task information

Figure 99: Extended Diagnosis > [Folder Name] > Task Information Example Display

Name Description
Identifier Identification number of the task
Major version Task version, contains incompatible changes
Minor version Task version, contains compatible changes
Maximum packet size Maximum packet size, which the task sends
Default Queue Queue handle, which is accessible via DPM by mailbox.
UUID Unique user ID, 16 Byte indicator used for task identification and its affiliation e. g. to a

stack (therein different identification data is coded in).
Init result Error Code, 0= no Error

The description of the error codes can be found in this manual or in the corresponding
software reference manuals.

Table 35: Extended Diagnosis > [Folder Name] > Task Information

DTM for Hilscher PROFINET IO-Controller devices (RT/IRT) | Configuration of contoller devices
DOC150704OI08EN | Revision 8 | English | 2023-07 | Released | Public

© Hilscher 2015 – 2023



Extended diagnosis 133/164

8.3 IniBatch status

Figure 100: Extended Diagnosis > [Folder name] > IniBatch Status example display

Name Description
Communication Channel Number of the communication channel used by the device.
Current State Idle; 

IniBatch packets in progress; 
Retrying to send last packet; 
Error

IniBatch Result Ok; 
No DBM file; 
No Packet table; 
No data set available; 
Data set is shorter than packet length; 
Packet Buffer is shorter than Packet length; 
Invalid packet destination; 
Logical queue not defined Send packet failed; 
Too many retries; 
Error in confirmation packet status

OpenDbm Result Error when opening the IniBatch database 
Under "OpenDbm Result" the error code is typed in, when "IniBatch Result" == "No DBM
file" (1) is.

SendPacket Result Error when sending a packet 
Under "SendPacket Result" the error code is typed in, when "IniBatch Result" == “send
packet failed" (8) is.

Confirmation Result Confirmation error when sending packets
Under "Confirmation Result" the packet specific error code from the ulSta is typed in,
when "IniBatch Result " == "Error in confirmation packet status" (10) is.

Last Packet Number Value depends by the communication system.
Last Packet Command Value depends by the communication system.
Last Packet Length Value depends by the communication system.
Last Packet Destination Value depends by the communication system.

Table 36: Extended Diagnosis > [Folder name] > IniBatch Status

The task status "Confirmation Result" is bus specific. The other task status
are rcx-related error codes.
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8.4 PNM_AP

8.4.1 Configuration state

Figure 101: Extended diagnosis > PNM_AP > Configuration state

For each Slave device (1 to 128) possible in the PROFINET network, a
device handle is passed to the firmware, including information about the
Slave configuration status.

Name Description Range of value/value
Last configuration error code Error code indicating which error occurred in the last

misconfigured device handle.
See API manual Hilscher
status and error codes,
Firmware and driver

Handle of element with
configuration error

Displays the station address of the PROFINET IO-Device for
the operating mode IRT, which was last detected as faulty
configured.

1 … 128

Configuration state of device
handle [1 … 128]

Each device handle passes, the information to the firmware,
whether a slave is configured for RT or IRT. Furthermore, an
information is passed if a slave is not available or if no slave
has been configured (not configured) or if the slave has been
switched off. 'Switched off' means that no connection to this
slave is established during operation.

Not available, Not
configured, Deactivated, 
Configured for RT,
Configured for IRT

Table 37: Extended diagnosis > PNM_AP > Configuration state

The displayed device handles match to the file handles of the acyclic
services. A file handle is an addressing of file operations.
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8.4.2 Network state

Figure 102: Extended diagnosis > PNM_AP > Network state

Name Description Range of value/value
Name of station Network name of the PROFINET IO-Device station. 1 - 240 characters
IP address IP address of the PROFINET IO-Device station. Valid IP address
IP network mask Network mask of the PROFINET IO-Device station. Valid IP network mask
IP gateway address Gateway address of the PROFINET IO-Device station. Valid IP gateway address
Bus state Shows the current state on the bus (DPM bus state) for the

states if the bus is not in operation (Off), if the communication
is started on the bus (Startup), if the bus is in operation (On)
and if the communication is stopped and the bus is shut down
(shutdown).

Off, 
Startup, 
On, 
Shutdown

Address conflict detection The firmware checks in cyclic intervals if a conflict exists and
displays the result.
Address conflicts can occur for the name of station or the IP
address or for both.

No conflict,
Name of station conflict,
IP address conflict,
Name of station conflict,
IP address conflict

Conflicting name of station
MAC address

If a name of station conflict is detected, the MAC address of
the station with the same name of station is displayed.

00-00-00-00-00-00 … 
FF-FF-FF-FF-FF-FF

Conflicting IP MAC address If an IP address conflict is detected, the MAC address of the
station with the same IP address is displayed.

00-00-00-00-00-00 … 
FF-FF-FF-FF-FF-FF

Table 38: Extended diagnosis > PNM_AP > Network state
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8.4.3 Communication state

Figure 103: Extended diagnosis > PNM_AP > Communication state

Name Description Range of value/value
Communication state
of device handle [1 …
128]

Each device handle passes the information to the
firmware in which communication state, the
respective Slave is.

Not available
Not configured
Deactivated
No link
Connecting - Startup
Connecting - Parameterization
Connecting - Waiting for ready
In data exchange
In data exchange, Configuration
mismatch
In data exchange, Diagnosis available
In data exchange, Configuration
mismatch, Diagnosis available

Table 39: Extended diagnosis > PNM_AP > Communication state
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8.4.4 Most recent logbook entries

Figure 104: Extended diagnosis > PNM_AP > Most recent logbook entries

Name Description Range of value/value
Time since device start Time since boot in seconds. 0 …
Entry [0 … 23] time Intelligent timestamp: Same events are detected. The time

stamp is updated.
0 …

Entry [0 … 23] device Handle Affected device handle 0x0001 to 0x0128
Entry [0 … 23] event Possible event type Unused,

Configuration changed,
Configuration locked,
Low priority alarm,
High priority alarm,

RPC read failed,
Connection not
established,
Connection established,
Memory usage,
Connection aborted,
Host interface watchdog
error,
RPC write failed,
Bus state changed
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Name Description Range of value/value
Entry [0 … 23] detail Error code indicating which error occurred respectively for the

events in the logbook.
See API manual Hilscher
status and error codes,
Firmware and driver. In
addition, error codes can
be displayed which come
directly from the bus.
These are 32-bit values
described in the
PROFINET specification.

Table 40: Extended diagnosis > PNM_AP > Most recent logbook entries

8.4.5 PROFINET interface state

Figure 105: Extended diagnosis > PNM_AP > PROFINET interface state

If the firmware gets neighborhood information by a topology configuration,
the PROFINET interface status shows the evaluation of the checks carried
out by the PROFINET IO IRT Controller for proximity detection.

Name Description Range of value/value
Local port diagnosis 
port 1 (or 2)

Indicates whether to the appropriate port 
- an error was detected or 
- that the port is not connected, 
- the wrong MAUType or 
- the wrong cable delay.

OK, 
No link, 
Wrong MAUType, Wrong
cable delay

Remote port diagnosis port 1
(or 2)

Indicates whether to the corresponding neighboring port 
- an error was detected or 
- no or a wrong neighbor station, 
- the incorrect port or 
- the wrong MAUType, 
- the wrong media redundancy domain or 
- the wrong cable delay.

OK, 
No peer detected, 
Wrong peer, 
Wrong peer port, 
Wrong MAUType, 
Wrong MRP domain, 
Wrong cable delay

RTC3 port state port 1 (or 2) Displays the RTC3 port state for IRT configurations. In the
'Startup' state, the PROFINET IO-Devices still send their
frames unsynchronized to the PROFINET IO-Controller
device.

Off, 
Up (sending in red), 
Run (sending and
receiving in red)

Table 41: Extended diagnosis > PNM_AP > PROFINET interface state
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8.4.6 PROFINET switch diagnosis

Figure 106: Extended diagnosis > PNM_AP > PROFINET switch diagnosis

Name Description
[Service] Diagnosis counter. Indicates the services processed. (The services of the single packets

are described in the API manual.)
Table 42: Extended diagnosis > PNM_AP > PROFINET switch diagnosis

8.4.7 System state

Figure 107: Extended diagnosis > PNM_AP > System state

The diagnostic system status shows the total available RAM memory and
the currently used RAM in bytes as well as the CPU usage in %.

DTM for Hilscher PROFINET IO-Controller devices (RT/IRT) | Configuration of contoller devices
DOC150704OI08EN | Revision 8 | English | 2023-07 | Released | Public

© Hilscher 2015 – 2023



Tools 140/164

9 Tools

9.1 Overview tools
Under "Tools", the Packet monitor and the IO monitor are provided for test
and diagnosis purposes.
· In the "Packet Monitor", data packets are used to communicate with the

firmware and are exchanged between the application (configuration
software) and the firmware in the device.

· The "I/O Monitor" offers an easy way to display data of the process
image and to change the output data.

Figure 108: Navigation area - Tools (example)

Online connection to the device

Note:
Accessing the Tools dialog panes of the PROFINET IO-Controller
DTM requires an online connection from the PROFINET IO-
Controller DTM to the PROFINET IO-Controller device. For further
information refer to section Connecting/disconnecting
device [} page 107].
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9.2 Packet monitor
The Packet monitor serves for test and diagnosis purposes.

Data packets, i. e. messages are self-contained blocks of defined data
length. The packets are used to communicate with the firmware and they
are exchanged between the application (configuration software) and the
firmware in the device. Packets can be sent once or cyclically to the
connected device controlled by the user and packets received can be
displayed.

Data packets comprise from a Packet header and the Send data or from a
Packet header and the Receive data. The packet header can be
evaluated by the receiver of the packet and contain the sender and receiver
address, the data length, an ID number, status and error messages and the
command or response code. The minimum packet size amounts 40 Byte
for the packet header. The sending and receiving data is added.

For further information to the packet description, refer to the
Protocol API Manual.

Ø Open the Packet monitor via Tools > Packet monitor.

Figure 109: Packet monitor

Display mode switches the representation of the send and reception data
between decimal and hexadecimal.
Ø Select Reset counter to reset the packet counter.
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9.2.1 Sending packet

Figure 110: Send > Packet header and Send data

Packet header

Under Send > Packet header the elements of the packet header of the
sending packet are displayed, which is transmitted from the application
(configuration software) to the device. The packet header of the sending
packets contain the elements described in the following table.

Element Description
Dest Destination Queue Handle Contains the identifier of the receiver for the packet 

(destination task queue of the firmware).
Src Source Queue Handle Contains the identifier of the sender of the packet (sending task).
Dest ID Destination Queue Reference Contains an identifier for the receiver of unsolicited sent packets from the

firmware to the application (configuration software).
Src ID Source Queue Reference Contains an identifier of the sender.
Len Packet Data Length (in bytes) Length of the send respectively receive data.
ID Packet Identification 

As Unique Number
Identifies identical data packets among each other.

State Status / Error Code Transmits status or error codes to the packet sender.
Cmd Command / Response Code Command or respond code.
Ext Extension Field for extensions (reserved).
Rout Routing Information Internal value of the firmware.

Table 43: Descriptions Packet header

Ø Under Dest select the receiver (destination task queue).
Ø Under Cmd select the command identification (Request).

Auto Increment ID is an increment for the identifier of the data packets
and increments the ID by 1 for each newly sent packet.

Send data
Ø Under Send > Send data enter the send data of the packet, which shall

be transmitted from the application (configuration software) to the
mailbox of the device. The meaning of the transmitted data depends on
the command or response code.

Sending packets once or cyclic
Ø To send packet "once", select Put packet.
Ø To send packet "cyclic", select Put cyclic.
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9.2.2 Receiving packet

Figure 111: Packet header and Receive data

Packet header

Under Receive > Packet header the elements of the packet header of the
receiving packet are displayed, which are transmitted back from the device
to the application (configuration software). The packet header of the
receiving packets contain the elements described in the following table.

Element Description
Dest Destination Queue Handle Contains the identifier of the receiver for the packet 

(destination task queue of the firmware).
Src Source Queue Handle Contains the identifier of the sender of the packet (sending task).
Dest
ID

Destination Queue Reference Contains an identifier for the receiver of unsolicited sent packets from the
firmware to the application (configuration software).

Src ID Source Queue Reference Contains an identifier of the sender.
Len Packet Data Length (in bytes) Length of the send respectively receive data.
ID Packet Identification 

As Unique Number
Identifies identical data packets among each other.

State Status / Error Code Transmits status or error codes to the packet sender.
Cmd Command / Response Code Command or respond code.
Ext Extension Field for extensions (reserved).
Rout Routing Information Internal value of the firmware.

Table 44: Descriptions Packet header

Receive data

Under Receive > Receive data the receiving data of the packet, which is
transmitted back from the device to the application (configuration software)
is displayed.
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9.3 I/O monitor
The IO monitor serves for test and diagnosis purposes. It provides to view
data of the process data image and to change output data easily. The
display is always in a Byte manner.

Note:
Only change and write output data if you know that no plant
disturbances are caused by this. All output data written by the IO
monitor is transmitted at the bus and have effect on subordinate
drives, IO etc.

Figure 112: IO monitor

Columns switches the number of columns.

Display mode switches the representation of the input and output data
between decimal and hexadecimal.

Offset / Go moves the indication of the data to the entered offset value.
Ø Enter the output value and select Update.
ð The data of the process image are always displayed, even if these

bytes are not reserved by the configuration.
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9.4 Process image monitor
The Process image monitor pane lists the Devices connected to the
controller, as well as the configured modules or input or output signals of
the devices. This makes visible the fieldbus structure and the data structure
of the device’s input and output data transmitted at the bus. Furthermore,
the values of the signal data provided to the OPC server are displayed
here.
Ø Open Tools > Process image monitor.

Figure 113: "Process image monitor" pane

Parameter Description Range of value/
value

Display mode Display of the values in the column Value in decimal or hexadecimal mode. Decimal (Default),
Hexadecimal

The tree shows the structure of the devices (1), modules (2) and the input data
(3) and output data (4).

Display when the input and output data is not completely read and analyzed.

Display when the input and output data is not valid.

Display when the input and output data is valid.

Type Device labeling provided by the hardware: 
Also description of the modules or input or output signals configured to the
device.
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Parameter Description Range of value/
value

TAG Device name provided by the hardware (not changeable in the FDT container) or
symbolic name for the modules configured to the device or for the input or output
signals (changeable in the Configuration > Process data pane).

Value Display of the valid input and output data values.
Last error Last occurred error (Description see appropriate Application Programming

Manual)
Table 45: Notes to the "Process image monitor" pane
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10.2 User rights
User-rights are set within the FDT-container. Depending on the level, the
configuration is accessible by the user or read-only.

To access the Settings, Configuration and Diagnosis panes of the
PROFINET IO-Controller DTM you do not need special user rights. Also all
users can select the decimal or hexadecimal Display mode or sort table
entries.

Note:
To edit, set or configure the parameters of the Settings and
Configuration panes, you need user rights for "Maintenance", for
"Planning Engineer" or for "Administrator".

The following tables give an overview of the user right groups and which
user rights you need to configure the single parameters.

10.2.1 Settings
Settings Observer Operator Maintenanc

e
Planning
engineer

Adminis-
trator

Driver Verifying or adapting driver
settings [} page 23]

D D X X X

Configuring netX
driver [} page 26]

D D X X X

Device
Assignme
nt

Scanning for devices [} page 32] D D X X X
Selecting the device (with or
without firmware) [} page 35]

D D X X X

Selecting the device once more
(with firmware) [} page 35]

D D X X X

Selecting and downloading
firmware [} page 37]

D D X X X

Licen-
sing

Licensing [} page 43] D D X X X

Table 46: User rights settings (D = displaying, X = editing, configuring)

10.2.2 Configuration
Configuration parameters Observer Operator Maintenanc

e
Planning
engineer

Adminis-
trator

Controller network settings [} page 71] D D X X X
Device table [} page 74] D D X X X
IP address table [} page 76] D D X X X
Process data [} page 78] D D X X X
Isochronous modules [} page 79] D D X X X
Address table [} page 82] D D X X X
FSU/port settings [} page 85] D D X X X
Stations timing [} page 87] D D X X X
Master settings D D X X X

Table 47: User rights configuration (D = displaying, X = editing, configuring)
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10.3 Name encoding
The name is an OctetString with 1 to 240 octets. A name can contain one
or more labels separated by a dot [.].

The definition of the IETF RFC 5890 and the following syntax apply:
· 1 or more labels, separated by [.].
· The total length is 1 to 240.
· The label length is 1 to 63.
· Labels consist of [a-z0-9-].
· Labels do not start with [-].
· Labels do not end with [-].
· Labels do not use multiple concatenated [-] except IETF RFC 5890.
· The first label does not have the form "port-xyz" or "port-xyz-abcde" with

a, b, c, d, e, X, y, z = 0...9 to avoid a false similarity to the
AliasNameValue field.

· Name of Stations do not have the form a.b.c.d with a, b, c, d = 0...999.
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10.4 Conventions in this document

Instructions
1. Operation purpose
2. Operation purpose

Ø Instruction

Results

 Intermediate result

 Final result

Signs

Sign Note
General note

Important note that must be followed to prevent malfunctions.

Reference to further information

Table 48: Signs

Signal words
Signal
word

Description

DANGER Indicates a hazardous situation, which if not avoided, will result in death or
serious injury.

WARNING Indicates a hazardous situation, which if not avoided, could result in death or
serious injury.

CAUTION Indicates a hazardous situation, which if not avoided, may result in minor or
moderate Injury.

NOTICE Indicates a property damage message.
Table 49: Signal words
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10.5 Legal notes

Copyright

© Hilscher Gesellschaft für Systemautomation mbH

All rights reserved.

The images, photographs and texts in the accompanying materials (in the
form of a user's manual, operator's manual, Statement of Work document
and all other document types, support texts, documentation, etc.) are
protected by German and international copyright and by international trade
and protective provisions. Without the prior written consent, you do not
have permission to duplicate them either in full or in part using technical or
mechanical methods (print, photocopy or any other method), to edit them
using electronic systems or to transfer them. You are not permitted to make
changes to copyright notices, markings, trademarks or ownership
declarations. Illustrations are provided without taking the patent situation
into account. Any company names and product designations provided in
this document may be brands or trademarks by the corresponding owner
and may be protected under trademark, brand or patent law. Any form of
further use shall require the express consent from the relevant owner of the
rights.

Important notes

Utmost care was/is given in the preparation of the documentation at hand
consisting of a user's manual, operating manual and any other document
type and accompanying texts. However, errors cannot be ruled out.
Therefore, we cannot assume any guarantee or legal responsibility for
erroneous information or liability of any kind. You are hereby made aware
that descriptions found in the user's manual, the accompanying texts and
the documentation neither represent a guarantee nor any indication on
proper use as stipulated in the agreement or a promised attribute. It cannot
be ruled out that the user's manual, the accompanying texts and the
documentation do not completely match the described attributes, standards
or any other data for the delivered product. A warranty or guarantee with
respect to the correctness or accuracy of the information is not assumed.

We reserve the right to modify our products and the specifications for such
as well as the corresponding documentation in the form of a user's manual,
operating manual and/or any other document types and accompanying
texts at any time and without notice without being required to notify of said
modification. Changes shall be taken into account in future manuals and do
not represent an obligation of any kind, in particular there shall be no right
to have delivered documents revised. The manual delivered with the
product shall apply.

Under no circumstances shall Hilscher Gesellschaft für Systemautomation
mbH be liable for direct, indirect, ancillary or subsequent damage, or for
any loss of income, which may arise after use of the information contained
herein.
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Liability disclaimer

The hardware and/or software was created and tested by Hilscher
Gesellschaft für Systemautomation mbH with utmost care and is made
available as is. No warranty can be assumed for the performance or
flawlessness of the hardware and/or software under all application
conditions and scenarios and the work results achieved by the user when
using the hardware and/or software. Liability for any damage that may have
occurred as a result of using the hardware and/or software or the
corresponding documents shall be limited to an event involving willful intent
or a grossly negligent violation of a fundamental contractual obligation.
However, the right to assert damages due to a violation of a fundamental
contractual obligation shall be limited to contract-typical foreseeable
damage.

It is hereby expressly agreed upon in particular that any use or utilization of
the hardware and/or software in connection with
· Flight control systems in aviation and aerospace;
· Nuclear fission processes in nuclear power plants;
· Medical devices used for life support and
· Vehicle control systems used in passenger transport

shall be excluded. Use of the hardware and/or software in any of the
following areas is strictly prohibited:
· For military purposes or in weaponry;
· For designing, engineering, maintaining or operating nuclear systems;
· In flight safety systems, aviation and flight telecommunications systems;
· In life-support systems;
· In systems in which any malfunction in the hardware and/or software

may result in physical injuries or fatalities.

You are hereby made aware that the hardware and/or software was not
created for use in hazardous environments, which require fail-safe control
mechanisms. Use of the hardware and/or software in this kind of
environment shall be at your own risk; any liability for damage or loss due
to impermissible use shall be excluded.

Warranty

Hilscher Gesellschaft für Systemautomation mbH hereby guarantees that
the software shall run without errors in accordance with the requirements
listed in the specifications and that there were no defects on the date of
acceptance. The warranty period shall be 12 months commencing as of the
date of acceptance or purchase (with express declaration or implied, by
customer's conclusive behavior, e.g. putting into operation permanently).
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The warranty obligation for equipment (hardware) we produce is 36
months, calculated as of the date of delivery ex works. The aforementioned
provisions shall not apply if longer warranty periods are mandatory by law
pursuant to Section 438 (1.2) BGB, Section 479 (1) BGB and Section 634a
(1) BGB [Bürgerliches Gesetzbuch; German Civil Code] If, despite of all
due care taken, the delivered product should have a defect, which already
existed at the time of the transfer of risk, it shall be at our discretion to
either repair the product or to deliver a replacement product, subject to
timely notification of defect.

The warranty obligation shall not apply if the notification of defect is not
asserted promptly, if the purchaser or third party has tampered with the
products, if the defect is the result of natural wear, was caused by
unfavorable operating conditions or is due to violations against our
operating regulations or against rules of good electrical engineering
practice, or if our request to return the defective object is not promptly
complied with.

Costs of support, maintenance, customization and product care

Please be advised that any subsequent improvement shall only be free of
charge if a defect is found. Any form of technical support, maintenance and
customization is not a warranty service, but instead shall be charged extra.

Additional guarantees

Although the hardware and software was developed and tested in-depth
with greatest care, Hilscher Gesellschaft für Systemautomation mbH shall
not assume any guarantee for the suitability thereof for any purpose that
was not confirmed in writing. No guarantee can be granted whereby the
hardware and software satisfies your requirements, or the use of the
hardware and/or software is uninterruptable or the hardware and/or
software is fault-free.

It cannot be guaranteed that patents and/or ownership privileges have not
been infringed upon or violated or that the products are free from third-party
influence. No additional guarantees or promises shall be made as to
whether the product is market current, free from deficiency in title, or can be
integrated or is usable for specific purposes, unless such guarantees or
promises are required under existing law and cannot be restricted.

Confidentiality

The customer hereby expressly acknowledges that this document contains
trade secrets, information protected by copyright and other patent and
ownership privileges as well as any related rights of Hilscher Gesellschaft
für Systemautomation mbH. The customer agrees to treat as confidential all
of the information made available to customer by Hilscher Gesellschaft für
Systemautomation mbH and rights, which were disclosed by Hilscher
Gesellschaft für Systemautomation mbH and that were made accessible as
well as the terms and conditions of this agreement itself.

The parties hereby agree to one another that the information that each
party receives from the other party respectively is and shall remain the
intellectual property of said other party, unless provided for otherwise in a
contractual agreement.
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The customer must not allow any third party to become knowledgeable of
this expertise and shall only provide knowledge thereof to authorized users
as appropriate and necessary. Companies associated with the customer
shall not be deemed third parties. The customer must obligate authorized
users to confidentiality. The customer should only use the confidential
information in connection with the performances specified in this
agreement.

The customer must not use this confidential information to his own
advantage or for his own purposes or rather to the advantage or for the
purpose of a third party, nor must it be used for commercial purposes and
this confidential information must only be used to the extent provided for in
this agreement or otherwise to the extent as expressly authorized by the
disclosing party in written form. The customer has the right, subject to the
obligation to confidentiality, to disclose the terms and conditions of this
agreement directly to his legal and financial consultants as would be
required for the customer's normal business operation.

Export provisions

The delivered product (including technical data) is subject to the legal
export and/or import laws as well as any associated regulations of various
countries, especially such laws applicable in Germany and in the United
States. The products / hardware / software must not be exported into such
countries for which export is prohibited under US American export control
laws and its supplementary provisions. You hereby agree to strictly follow
the regulations and to yourself be responsible for observing them. You are
hereby made aware that you may be required to obtain governmental
approval to export, reexport or import the product.

10.6 Registered trademarks
Windows® XP, Windows® Vista, Windows® 7, Windows® 8, Windows® 8.1,
Windows® 10 and Windows® 11 are registered trademarks of the Microsoft
Corporation.

PROFINET® is a registered trademark of PROFIBUS & PROFINET
International (PI), Karlsruhe.

CODESYS® is a registered trademark of 3S-Smart Software Solutions
GmbH, Germany.

All other brands mentioned are property of their respective owner of the
rights. Any company names and product designations provided in this
document may be brands (company names or trademarks) of the
corresponding owner and may be protected under trademark or patent law.
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Glossary
CODESYS COntroller DEvelopment SYStem: Development environment for

programming controller applications (PLC) according to the
international industrial standard IEC 61131-3

Controller Type of device that initiates and controls the communication on the
bus

Data packet Data packets, i. e. messages are self-contained blocks of defined
data length. The packets are used to communicate with the firmware
and they are exchanged between the application (configuration
software) and the firmware in the device.

DCP Discovery and basic configuration protocol: Protocol for identifying
and configuring devices, which is defined within the PROFINET
specification

Device Type of device that is configured by the controller and which then
performs the communication

DNS Domain Name System: hierarchical distributed naming system for
computers, services, or any resource connected to the Internet or a
private network

DTM Device Type Manager: Software module with graphical user interface
for the configuration and/or for diagnosis of devices

Ethernet Network technology used both for office and industrial communication
via electrical or optical connections. It has been developed and
specified by the Intel, DEC and XEROX, provides data transmission
with collision control and allows various protocols. As Ethernet is not
necessarily capable for real-time application, various real-time
extensions have been developed (industrial Ethernet, real-time
Ethernet).

FDT Field Device Tool: FDT specifies an interface, in order to be able to
use DTM (Device Type Manager) in different applications of different
manufacturers

Gateway address IP address of a gateway

GSDML file A special kind of XML-based Device Description File used by
PROFINET. (GSDML = General Station Description Markup
Language).

IP Internet Protocol: Belongs to the TCP/IP family of protocols and is
defined in RFC791 (available on http://www.ietf.org/rfc/rfc791.txt). It is
based on layer 3 of the ISO/OSI 7 layer model of networking and is a
connectionless protocol, i. e. you do not need to open a connection to
a computer before sending an IP data packet to it. Therefore, IP is not
able to guarantee that the IP data packets really arrive at the
recipient. On IP level, neither the correctness of data nor the
consistence and completeness are checked. IP defines special
addressing mechanisms; see IP address.
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IP address Identifies a device or a computer within an IP-based network and is
defined in the Internet Protocol Version 4 (IPv4) as a 32-bit number.
For ease of notation, the address is usually divided into four 8-bit
numbers represented in decimal notation and separated by points:
a.b.c.d. Each letter stands for an integer value between 0 and 255,
e.g. 192.168.30.16. However, not all combinations are allowed, some
are reserved for special purposes. The IP address 0.0.0.0 is defined
as invalid.

IRT Isochronous Real-Time: The application uses a time control unit for
the synchronized setting of the output data or for the capturing of the
input data.

MAC-ID Media Access Control-ID: unique (physical) Ethernet address of the
device on delivery, defined as 48 bit number; for ease of notation it is
divided into six 8 bit numbers which are represented in hexadecimal
notation and separated by “minus”-signs (-): A-B-C-D-E-F (A-B-C-D-
E-F each are integer values between 0 and 0XFF=255),
Example:00-02-A2-20-91-18

MAU Medium Access Unit: Transmitting and receiving device for signals
(for feeding signals into and extracting them from the media). On the
side of the network medium (cable), the device is the interface for
connecting network stations.

Module Hardware or logical component of a physical device

Name of station Network name of a PROFINET Device or Controller, set in the
Controller application. The name must comply to the PROFINET
specification and must be unique across the communication network.

Network mask Bit mask for separation between network part and device part in IP
addresses in the network protocol IPv4. The network part must be the
identical for all devices of the corresponding network, while the device
part is different. This is used to specify whether the device searches
for a given IP address in its own network (device part) or can reach
the IP address in other networks via router (network part). See also
https://en.wikipedia.org/wiki/IPv4_subnetting_reference Example:
255.255.255.0 (network part 255 255 255, device part 0)

netX networX on chip, Hilscher network communication controller. High
integrated network controller with optimized system architecture for
communication and maximum data transfer.

ODMV3 Online-Data-Manager Version 3: Application interface, respectively
works as a server, which can be run as an out-proc server or system
service. Its task is to provide different applications (e. g. SYCON.net),
access to multiple devices and even share one device amongst
several applications.

PROFINET Communication system for Industrial Ethernet, designed and
developed by PROFIBUS & PROFINET International (PI), which uses
some mechanisms similar to those of the PROFIBUS field bus

PROFINET IO PROFINET IO (Input - Output) has been created for the connection of
remote peripheral to a controller

DTM for Hilscher PROFINET IO-Controller devices (RT/IRT) | Configuration of contoller devices
DOC150704OI08EN | Revision 8 | English | 2023-07 | Released | Public

© Hilscher 2015 – 2023



Glossary 163/164

PROFINET IO-Controller PROFINET control unit responsible for the defined run-up of an I/O
subsystem and the cyclic or acyclic data exchange

PROFINET IO-Device PROFINET field device that cyclically receives output data from its
IO-Controller and responds with its input data

PROFINET IRT PROFINET protocol level for PROFINET IO applications in drive
systems with cycles times of less than 1 ms; IRT = Isochronous real-
time

RPC Remote Procedure Call: Mechanism to call a code on another
computer in the network (standard used by PROFINET)

RT Real-Time: PROFINET protocol level for PROFINET CBA and
PROFINET IO applications up to 10 ms cycle times

SCADA Supervisory Control and Data Acquisition: A concept for the control
and data acquisition of technical processes

Submodule Hardware or logical component of a physical device.

SYCON.net Multiprotocol-capable Hilscher configuration and diagnosis software
(FDT frame application), that can be used to configure
communication-capable fieldbus devices of different manufacturers in
one project

TCP/IP Transport Control Protocol/Internet Protocol connection-orientated,
secure transfer protocol as basis for the Internet-protocols

USB Universal Serial Bus

XML Extended Markup Language: symbolic language for structuring data
systematically which is maintained as a standard by the W3C (World-
wide web consortium). Device Description Files often use XML-based
formats for storing the device-related data appropriately.
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Contacts
HEADQUARTER
Germany
Hilscher Gesellschaft für 
Systemautomation mbH
Rheinstraße 15
65795 Hattersheim
Phone: +49 (0) 6190 9907-0
Fax: +49 (0) 6190 9907-50
E-mail: info@hilscher.com
Support
Phone: +49 (0) 6190 9907-990
E-mail: hotline@hilscher.com

SUBSIDIARIES
China
Hilscher Systemautomation (Shanghai) Co. Ltd.
200010 Shanghai
Phone: +86 (0) 21-6355-5161
E-mail: info@hilscher.cn
Support
Phone: +86 (0) 21-6355-5161
E-mail: cn.support@hilscher.com

France
Hilscher France S.a.r.l.
69800 Saint Priest
Phone: +33 (0) 4 72 37 98 40
E-mail: info@hilscher.fr
Support
Phone: +33 (0) 4 72 37 98 40 
E-mail: fr.support@hilscher.com

India
Hilscher India Pvt. Ltd.
Pune, Delhi, Mumbai, Bangalore
Phone: +91 8888 750 777
E-mail: info@hilscher.in
Support
Phone: +91 020-24243777
E-mail: info@hilscher.in

Italy
Hilscher Italia S.r.l.
20090 Vimodrone (MI)
Phone: +39 02 25007068
E-mail: info@hilscher.it
Support
Phone: +39 02 25007068
E-mail: it.support@hilscher.com

Japan
Hilscher Japan KK
Tokyo, 160-0022
Phone: +81 (0) 3-5362-0521
E-mail: info@hilscher.jp
Support
Phone: +81 (0) 3-5362-0521
E-mail: jp.support@hilscher.com

Republic of Korea
Hilscher Korea Inc.
13494, Seongnam, Gyeonggi
Phone: +82 (0) 31-739-8361
E-mail: info@hilscher.kr
Support
Phone: +82 (0) 31-739-8363
E-mail: kr.support@hilscher.com

Austria
Hilscher Austria GmbH 
4020 Linz
Phone: +43 732 931 675-0
E-mail: sales.at@hilscher.com
Support
Phone: +43 732 931 675-0
E-mail: at.support@hilscher.com

Switzerland
Hilscher Swiss GmbH 
4500 Solothurn
Phone: +41 (0) 32 623 6633
E-mail: info@hilscher.ch
Support
Phone: +41 (0) 32 623 6633
E-mail: support.swiss@hilscher.com

USA
Hilscher North America, Inc. 
Lisle, IL 60532
Phone: +1 630-505-5301
E-mail: info@hilscher.us
Support
Phone: +1 630-505-5301
E-mail: us.support@hilscher.com
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